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1.0 Loading and Starting Bentley Descartes 
 
 
The first step in using Descartes is to open a MicroStation drawing.  
 
 
Left click on the Add-Ons pull down menu just under the MicroStation V8 banner across the top of the screen. 
 

 
 
 
 
After selecting the Add-Ons pull down click the Descartes option at the bottom of the pull down. 
 
 
 
 
This will bring up the Descartes tool bar. 
 
 
 
 
 
 
 Loads Descartes Unloads Descartes Descartes Plotting 
 
 
Clicking the Load Descartes icon from the Descartes tool bar will bring up the Raster Manager. 
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1.1 Image Selection Set Support 
 
In previous version of Bentley Descartes, many functions were dependent on the image in focus or on the 
active image. This concept is no longer existent in the present version, as the functions now use the selected 
(highlighted) image(s) in Raster Manager. It is therefore possible to have more than one image selected at 
once, such that Bentley Descartes now adds image selection set support to Raster Manager. Several Bentley 
Descartes operations were enhanced to allow multiple images to be processed simultaneously. 
 
The list of tools that support image selection follows: 
 
Modify Image  Move   Scale   Rotate    
Mirror   Square   Warp   Merge 
Corridor  Clip   Unclip   Modify Clip 
Paint   Erase   Cleanup  Register 
Convert Text  Convert Cells  Undo/Redo 

 
Note that Image Selection Set is an additional feature only available when Bentley Descartes is loaded 
and running and not available with the Raster Manager alone. 

 
Bentley Descartes has been designed to seamlessly integrate into the MicroStation environment. 
Therefore, you will find that all tool boxes, menus, dialog boxes, and other interface operations are 
consistent with MicroStation conventions. 

 
 
1.2 Descartes Main Menu 
 
The main menu of Bentley Descartes is in fact the main Raster Manager dialog box. The structure of this 
menu is detailed in “Raster Manager Menu Structure”. 
 
The menu items of each Raster Manager menu are explained in the section titled Navigating Bentley 
Descartes.  
 
The Descartes Dialogs 
 
Because Bentley Descartes relies on Raster Manager to access images, Bentley Descartes uses the Raster 
Manager dialog to display its menus. The table below displays the Raster Manager menu when Bentley 
Descartes is loaded.  

 

The items highlighted in yellow are the ones 
added to the Raster Manager dialog. The 
items highlighted in blue represent Raster 
Manager tools to which Bentley Descartes 
adds more functionality. 
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1.3 Tool Frames and Tool Boxes 
 
All of the functionality of Bentley Descartes is also accessible through the tool boxes. 
 
Tool Boxes 
 
Each tool box gives access to a few tools of the same family.  
All tool boxes can be accessed from the Raster Manager Tools menu, where they are listed in alphabetical 
order. 
 
Tool Frame 
 
The Image tool frame is provided with Bentley Descartes. This tool frame can be accessed through the 
MicroStation>Tools>Raster>Descartes menu. It provides access to all the Bentley Descartes tool boxes. 
 

 
 
 
1.4 Managing and Selecting Files 
  
In Bentley Descartes, your project settings and status are managed through a standard file interface. 
Additionally, several distinct file types that are used as building blocks in your projects are also managed 
through the same file interface. If you are familiar with the standard file interfaces that are used in 
MicroStation, you should find the Bentley Descartes file interface easy to use. 
 
In Bentley Descartes, the file interfaces are used to manage the following types of files: 
 
File Type Extension 

Image files iTIFF, HMR, CIT, COT, RGB, RLE, A, P, JPG, PCX, RS, TGA, TIF, BMP, CAL, RLC, TG4, 
C29, C30, C31, PNG, ECW, SID 

Color Mask file MSK 
Node file NOD 
Register file RGR 
Resampling file RSP 
 
The file interface is used to create, open, select, and save the various types of files that are used in Bentley 
Descartes and the usual operations that are supported are New, Attach, Save and Save As. 
 
To support the selection of files, Bentley Descartes provides a simple and standard selection interface. The 
files listed for selection in the File list box have an extension specific to the file type (for example, MSK is the 
extension for a Color Mask file). The current directory displays above the Directories list box. You can change 
any of these selections. 
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2.0 Navigating Bentley Descartes 
 
This chapter describes how to navigate through the user interface to access all functions or features such as 
dialog boxes, tool boxes, tools, or any specific item in the Raster Manager menu structure that is added or 
modified by the Bentley Descartes application. 
 
Bentley Descartes uses the Raster Manager main dialog to display its menus. The Raster Manager menu bar 
provides access to seven menus. 
 

 
 

• The File menu is not modified by the Bentley Descartes application. 
 

• Several items are added to the Edit menu and some items are modified by the Bentley Descartes 
application. 

 
• One (1) item is added to the Display menu by the Bentley Descartes application. 

 
• Three (3) items are added to the Settings menu by the Bentley Descartes application. 

 
• The Tools menu is added to the Raster Manager menu structure by the Bentley Descartes application. 

 
• The Utilities menu is added to the Raster Manager menu structure by the Bentley Descartes 

application. 
 

• The Help menu is added to the Raster Manager menu structure by the Bentley Descartes application. 
 
The table below illustrates the menus and menu items that are specific to Bentley Descartes (highlighted in 
yellow) as well as those that are modified by the Bentley Descartes application (highlighted in blue).  
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2.1 Raster Manager Dialog Box 
 
All Bentley Descartes functions can be accessed from the Raster Manager dialog box. 
 
To open the Raster Manager dialog box 
 

1. From the MicroStation File menu, choose Raster Manager.  
 
or 
 

1

2. From the MicroStation Tools menu, choose Raster > Control to open the Descartes Raster Control 
tool box, then select the Raster Manager tool. 
The Raster Manager dialog box opens, displaying names of any attached raster images. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2

2

1

The Raster Manager dialog list box is customizable. You can selectively disable or enable individual fields 
from the list box menu bar using a contextual menu (right-click). 
 
The following fields can be displayed: 
 

• The Quick Info field is used to display a short description of the raster. When the cursor is placed over 
this field, a tool tip brings up the description corresponding to the raster. 

 
• The File Name field is used to display the file name. 

 
• The Description field is used to present a description of the file. 

 
• The Logical Name field is used to display the file's logical name. 

 
• The Read-Only field is used to indicate if the file is in read-only mode. 

 
• The new On-the-Fly only works with MicroStation GeoGraphics. We do not use MicroStation 

GeoGraphics here at MoDOT at this time. 
 

• The Geo Priority field is used to display the method used to geographically position the image. The 
available choices are Attachment, Raster Header and Sister File. The image may have native 
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geographic metadata stored in the image itself (raster header) or in a companion file (sister file or 
world file). When no native methods are present, the user geographically positions the image and the 
metadata is stored in the design file. This method is called “attachment”.  

 
The geographic metadata is always preserved and updated in the Attachment. When specified 
otherwise, the alternate location is updated as well as the attachment. Hence, the attachment is 
constantly updated to reflect the current geographic information of the image. 
 
To change the Geo Priority, simply click in the Geo Priority column. This will open the Geo Priority 
dialog box. You can then change the selection. 

 
 
 
 
 
 
 

Upon saving a raster file, the preferred Geo Priority for a raster attachment can be specified. When the 
raster file is reopened, if the raster cannot be reattached with the same Geo Priority, the raster will be 
displayed using a “dark yellowish” color in the Raster Manager dialog.  

 
• The Model field is used to display the origin (design name and model name) of the raster reference. 

We do not use Models here at MoDOT at this time. 
 

• The Status field displays the reference's status (Loaded, Referenced, Self-Referenced or Raster Not 
Found). 

 
To show or hide a field from the list box menu bar 
 

1. Open the Raster Manager dialog box. 
 

2. Position the pointer within the list box menu bar and right-click. 
The contextual menu displays. Enabled fields are indicated with checkmarks. 

 
3. Choose the menu item for the field you want to hide or show. 

 
 
 
2.2 Pull Down Menu Items 
 
Edit menu 
 
The Raster Manager Edit menu gives access to features for modifying, clipping, copying and pasting images. 
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Modify 
 
Used to modify a raster image’s origin, size, rotation or affinity. 
 
Move 
 
Used to move an image to a new location. 
 
Scale 
 
Used to change the proportionate dimensions of an image. 
 
Rotate 
 
Used to rotate an image. 
 
Mirror 
 
Used to mirror the selected raster image horizontally, vertically, or diagonally. Additionally, you can specify the 
axis about which the image is mirrored. 
 
Warp 
 
Used to adjust the size and shape of a raster image with a combination of move, scale, rotate, and skew 
options. 
 
Square 
 
Used to rotate a raster image by squaring a horizontal, vertical, or diagonal axis. 
 
Merge/Crop 
 
Used to copy and merge or to crop one or more images contained within a defined area. 
 
Corridor 
 
Used to copy the regions of one or more images contained within a polygon of the same shape. 
 
Clip 
 
Used to clip a raster image (Clip Boundary), or to define a masked area (Clip Mask). 
 
Modify Clip 
 
Used to modify the clipping polygon for a clipped raster image. 
 
Unclip 
 
Used to remove one or more clipping polygons from a raster image. 
 
Cut 
 
Removes (cuts) the selected element(s) to the clipboard for subsequent pasting. 
 
Copy 
 
Used to copy an area from the active image to the clipboard. 
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Paste 
 
Used to paste the image area in the clipboard at a specified location in the active image. 
 
Color Table 
 
Used to edit the selected image's color palette. This menu item is not available if 
no image is selected, if more than one image is selected, or if the selected 
image has no color palette.  
 
File menu > Open — Opens the Open Palette dialog box, which is used to load 
a new color table into the color tiles.  
 
File menu > Save As — Opens the Save Palette dialog box, which is used to 
save the Color Table as a color table file.  
 
File menu > Revert — Resets the Color Table to the active color table settings 
without closing the Color Table dialog box. 
 
2.3 Display menu 
 
The Raster Manager Display menu gives access to tools for displaying raster files. 
 

 
 
References 
 
Used to open the MicroStation Reference dialog box. 
 
Bring to Front 
 
Used to bring the selected raster image to the top of the other raster images. 
 
Send to Back 
 
Used to send the selected raster image to the back of the other raster images. 
 
Bring Forward 
 
Used to bring the selected raster image forward one raster image at a time. 
 
Send Back 
 
Used to send the selected raster image back one raster image at a time. 
 
Fit Rasters to View 
 
Used to fit the view to the selected raster image’s boundary. 
 
Fit All Rasters to View 
 
Used to fit the view to all the raster images in the design file. 
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Actual Resolution 
 
Used to view the selected raster image at a 1:1 actual resolution. 
 
Align View to Raster 
 
Used to align the view to the selected raster images rotation. 
 
2.4 Settings menu 
 
The Raster Manager Settings menu gives access to various setting boxes. 
 

 
 
Attachment 
 
The attachment setting shows information about the file information, location, color, and display. 
 
      
 
 
 
 
 
 
 
 
 
 
Descartes Attachment 
 
Shows the transparency and image background color settings. 
 

  
 
 
 
Update Sequence 
 
Used to determine the order in which the raster images update. 
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Raster Snap on Tentative 
 
Used to set up the snap options to a raster image. 
 
Entity 
 
The Entity option menu lets you choose whether to snap at the center of the raster lines (Line), or on the 
edges of the raster objects or lines (Outline), or not to snap at all (None). 
 
Mask 
 
Used to select a color mask from the open Color Mask file, to determine the raster objects or lines on which to 
snap.  
 
 
2.5 Tools menu 
 
With the Raster Manager Tools menu, you can access all Bentley Descartes tool boxes. 
 

 
 
Tool Boxes 
 
Each tool box gives access to a few tools of the same family.  
All tool boxes can be accessed from the Raster Manager Tools menu, where they are listed in alphabetical 
order. 
 
Tool Frame 
 
The Image tool frame is provided with Bentley Descartes. This tool frame can be accessed through the 
MicroStation>Tools>Raster>Descartes menu. It provides access to all the Bentley Descartes tool boxes. 
  
 
Raster 
 
Toggles the display of the main Raster tool box, which contains tools for displaying and controlling raster files. 
 
 
 
 
 
 
 
 
 
Raster Display 
 
Opens the Raster Display tool bar, which contains tools for displaying raster files. 
 
 

Navigating Descartes 206



Raster Control 
 
Opens the Raster Control tool box, which contains tools for controlling and manipulating raster files. 
 
 
 
 
 
 
 
Raster Descartes 
 
Opens the Image Main tool box, which provides access to all other tool boxes and, consequently, to all the 
functionality of Bentley Descartes. 
 
 
 
 
 
 
 
 
 
 
Color Mask 
 
The Color Mask tool box provides tools to add colors to a mask, to subtract colors from a mask, or to open the 
Color Mask dialog box. 
 
The Color Mask tool box gives access to the following tools: 
 

• Add to Mask tool 
 

• Subtract from Mask tool 
 

• Color Mask Dialog tool 
 
 
 
 
 
 
 
 
 
 
Cut / Copy / Paste 
 
Opens the Cut / Copy / Paste tool box and gives access to the following tools: 
 

• Cut Image Area 
 

• Copy Image Area 
 

• Paste Image Area 
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Mosaic 
 
Opens the Mosaic tool box and gives access to the following tools: 
 

• Balance Tone 
 

• Define Seam 
 
 
 
 
Node File 
 
Opens the Node File tool box and gives access to the following tools: 
 

• New Node File 
 

• Open Node File 
 

• Save Node File 
 

• Save Node File As 
 
 
 
Register 
 
Opens the Register tool box and gives access to the following tools: 
 

• Place Control Points 
 

• Move Control Point 
 

• Delete Control Points 
 

• Register Dialog 
 

• Resample Image 
 

• Resampling Dialog 
 

• Copy Vector 
 

• Move Vector 
 
 
 
Stamp Vector 
 
Opens the Stamp Vector tool box and gives access to the following tools: 
 

• Stamp Vector 
 

• Match Stamp Vector Settings 
 

• Stamp Vector Settings 
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Text / Cells 
 
Opens the Text / Cells tool box and gives access to the following tools: 
 

• Select Horizontal Text 
 

• Select Oriented Text 
 

• Select Multiple Text 
 

• Delete Text Selection 
 

• Convert Text 
 

• Text Settings 
 

• Convert Cell 
 

• Convert Horizontal Cell 
 

• Convert Oriented Cell 
 
 
Touch-up 
 
Opens the Touch-up tool box and gives access to the following tools: 
 

• Paint 
 

• Erase 
 

• Cleanup 
 
 
 
Vectorize 
 
Opens the Vectorize tool box and gives access to the following tools: 
 

• Place Element 
 

• Continue Element 
 

• Insert Element 
 

• Convert Lines 
 

• Convert All Connected Lines 
 

• Convert Contour Lines 
 

• Convert Circle 
 

• Place Nodes  
 

• Delete Nodes 
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2.6 Utilities menu 
 
The Raster Manager Utilities menu gives access to various dialog boxes for enhancing or registering images, 
creating color composites, and for rasterizing images. 
 

 
 
 
Color Compression 
 
Used to open the Color Compression dialog box. 
 
 
Color Mask 
 
Use to create and manage Color Masks. A mask can be assigned to any image regardless of the pixel type 
(except for binary images). When adding colors to a mask, it is possible to select the area on any image 
currently open in Raster Manager. 
 
 
Register 
 
Used to open the Register dialog box. 
 
 
Resampling 
 
Used to open the Resampling dialog box in order to apply a geometric correction model to an uncorrected 
image. 
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3.0 Enhancing Images 
 
The image enhancement tools are used to create a color composite image through color compression, or 
render regions of an image transparent.  
 
The transparent colors functionality is particularly useful in creating mosaics, since you can hide portions of 
images that you do not need.  
 
The following options are available: 
 
Color Compression 
 
Transparency and Backfill Color 
 
3.1 Color Compression dialog box 
 
The Color Compression dialog box is used to enter the parameters for producing a color composite image 
through color compression. The output image can be a RGB combination of three input images as seen 
through red, green, and blue filters. It can also be the result of color compression applied to a single file.  
 
To access the Color Compression dialog box, from the Raster Manager Utilities menu, select the Color 
Compression menu item. 
 

 
 
 

Input Image 
To select each of the input files, click the "Browse Location" 
buttons and use the Select Input Image dialog box.  
 
When each of the input images has an appropriate contrast 
and displays with clarity, the color composite resulting from the 
color compression should be clear and correctly contrasted. 
Choose any valid type of file as input except Binary files. 
 
Input Type 
 
Choose the "RGB Channels" option if you want to produce a 
RGB combination of three input images. 
 
Choose the "Single Channel" option if you want to apply a 
color compression on a single file.  

 
If the "RGB Channels" is selected, the three files selected must be grayscale channels (R-G-B). The grayscale 
palette is also supported. 
 
Compression Option 
 
Use to select the Number of Colors of the output image.  
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Output Image 
 
To specify the output file name, click the Browse Location button and use the Select Output Image dialog box. 
The file type, color mode and the data compression to be used can also be specified.  
 
Use Palette 
 
To use an existing palette, turn on the Use Palette toggle and use the Browse Location button to specify the 
raster file. 
 
Run 
 
The Run button can be accessed only when the parameters have been correctly entered. Click this button to 
create the output image with color compression. While the batch program is running, a Progress indicator 
displays.  
 
Cancel 
 
If you decide not to use the present parameters, click Cancel and the dialog box then closes.  
 
 
3.2 Transparency and Background Color Settings dialog box 
 
This dialog is used to change the default background color and to apply transparency to images. In both tabs, 
the right section display the image opened in Raster Manager. This dialog is modeless and therefore this list is 
synchronized with the Raster Manager list.  
 
To access the Transparency and Background Color Settings dialog box, from the Raster Manager Settings 
menu, choose Descartes Attachment. 
 

 
 
3.2a Transparency tab 

 
This tab is used to set transparency on images. 
Color masks are used to set colors as transparent. 
More than one mask can be assigned to an image. 
Each mask is applied with a percentage of 
transparency. If more than one mask is assigned to 
an image and the same color is set as transparent 
by more than one mask, the last mask applied to the 
image has priority.  
 
The (All) mask is used to add all colors from the 
target image to the mask. This mask is a system 
mask and cannot be modified or deleted. 
 
The (Background) mask is used to specify the color 
to be used for background operations (Erase, rotate, 
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etc.). The background color can be set under the “Image Background Color” tab. This is a system mask. It can 
e modified but cannot be deleted. 

g a new mask for 
mporary usage. This is a system mask. It can be modified but cannot be deleted. 

the 
binary images with other image types. 

hen binary images are selected, only two masks are available:  
 

• “(Foreground)” – Redefines Raster Manager foreground color for binary images.  
 

• “(Background)” – Redefines Raster Manager background color for binary images. 

o open the Transparency and Background Color Settings dialog box: 

. From the Raster Manager Settings menu, sele
 

b
 
The (Temp) mask is used to temporarily add/subtract colors. It simply avoids creatin
te
 
 
It is possible to assign the same mask to several images in one step. Multiple selections are supported in 
image list. When using multiple selections, it is not possible to mix 
W

 
 
T
 
1 ct Descartes Attachment. 

 
 
 
To assign a Mask and Transparency percentage to images: 

. From the Image/Transparency list, select the image(s) to which the mask will be assigned. 

. From the Mask list, select the mask to be assigned. 

. Set the percentage of tran

. Click on the Insert>> button. 
 

 
1
 
2
 
3 sparency 
 
4
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To remove a mask: 

1. t, find the image for which you want to remove a mask assignment and 
select the mask to be remo

. Click on the <<Remove button. 

 

 
From the Image/Transparency lis

ved.  
 
2
 
 
 

 
 
 
 
 
To modify the percentage of transparency of an assigned mask: 

. From the Image/Transparency list, find the image and select the mask you want to modify.  

. Change the percentage in the Edit Transparency field at the bottom right of the dialog. 

. Click Enter on the keyboard. 

 

 
1
 
2
 
3
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To modify the order masks are applied to the same image: 

. From the Image/Transparency list, select the image you want to modify and select the mask to be moved.  

. Right-click on the mask and select Move Up or Move Down. 

o add a new mask in the Mask list: 
 

1. Click on the Mask… button on the lower left of the dialog. This will open the Color Mask dialog.  
 

2. In the Color Mask dialog, select Tools > New Mask 
 

3. Name the mask and press the enter key. 

.2b Image Background Color tab 

 

round color for each image 
cluded in a mosaic. 

 

 all the images 
ill have the same background color. 

mple, when the Erase tool is used, all erased colors are 
placed with the background color. 

he default background color is assigned to all images.  
 

• For binary images, the default is the Background color as defined by Raster Manager. 
 

• For grayscale images, the default color is black (0,0,0) 
 

• For 8-bit color images, the default is index 0. 
 

• For 16 and 24-bit images, the default color is black (0,0,0) 

ferent depending of the selected image, it is only possible to change one 
ackground color at a time.  

o change a background color: 
 

1. Select an image from the Image/Background Color list. 
 

2. Select the color from the Background Color section and click the “Assign >>” button.  

 the background transparent. By 
oing so, an image will have its background automatically set as transparent. 

 

 
1
 
2
 
T

 
 
3
 
When processing images, it is often necessary to 
define the background color. Images that are from 
different sources or scale may not all share the same
background color value. Hence, it becomes tedious 
to set a different backg
in
 
The background color can be assigned at the 
beginning of a workflow, by using a specific RGB 
color. This color will be used by Bentley Descartes
whenever the background pixels need editing. By 
doing so, once a mosaic is completed,
w
 
The Image Background Color is used to assign a 
background color to an image. The background color 
is use by several Bentley Descartes tools. For exa
re
 
T

 
Because color choices are dif
b
 
T

 
Once the background color is set, a background mask can be applied to make
d
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4.0 Transforming Images 
 
This chapter shows how you can use the Descartes Raster Control tool box for quick transformations of raster 
objects, of image files or parts of image files in different geometric spaces. 
 

 
 
 
 

 
Raster Manager tool 
 
Used to open the Raster Manager Dialog Box. 
 

 
 
 
 
 
 
 
Attach tool 
 
Used to open the Attach Raster References Dialog Box. 
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4.1 Raster Selection tool 
 
Used to select a Raster file. 
 
 
 
 
 
4.2 Modify Image tool 
 
 
The Modify Image Tool allows the user to interactively change the shape of an image (location, scale, rotation, 
and affinity). This tool will affect the selected images. Multiple selections are allowed. 
 
 

 
 

 
Tool Setting Effect 

Origin X, Y and 
Z 

Sets the location, in working units, of the lower left corner of the selected raster file 
attachment. The Z field is grayed out when working with 2D images. 

Display When more than one image is selected, the Display will be based on the average pixel size of 
the selection set. 

Rotation Sets the rotation angle of the selected attached raster image. 
Affinity Sets the affinity angle for the selected attached raster image. 

 
 
To Modify an image with the Modify Image Tool 
 

1. From the Raster Control toolbox, select Modify Image tool. 
 

2. Using the pointer, enter a data point on the image to modify. 
 

3. Use the handles to move, scale, and rotate the image, as well as to modify the affinity angle. 
 
 

The data point also identifies the location of the Origin handle. 
 

 
When using the Modify tool to edit more than one image that are not all on the same z-axis, the images 
are surrounded by an imaginary cube, in order to visualize the relocated images. The imaginary cube 
displays in all views, except the Top View. 
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4.3 Move Raster tool 
 
Used to move an image to a new location. Move adjusts the origin or placement of the image. The pixel size, 
dimensions, and number of pixels remain unchanged. Multiple selections are allowed. All the selected images 
are moved. 
 

When using the Move Raster tool, you are able to snap to tentative points on an element. The AccuSnap 
mode is enabled when MicroStation Descartes is installed. 

 
To move a raster: 
 

1. From the Raster Control toolbox, select Move Raster tool. 
The tool settings window opens.  

 
2. By default, the Attach Copy toggle is turned OFF in the tool settings window. If you wish to create a 

new attachment of the image, select Attach Copy. 
 

3. Enter a data point at a known location on the image. A rectangle outlining the image appears. 
 

4. Move the cursor (the image outline follows) to the new location and enter a data point. This data point 
can be entered in any open view. 

 
 
 
4.4 Scale Raster tool 
 
Used to change the proportionate dimensions of an image. To scale an image, use an Active Scale or 3 Points 
Scale method. The Scale tool adjusts the origin, pixel size, and dimensions of the image. However, the 
number of lines and pixels remain unchanged. Multiple selections are allowed. All the selected images are 
scaled. 
 

When using the Scale Raster tool, you are able to snap to tentative points on an element. The AccuS
mode is enabled when MicroStation Descartes is installed. 

nap 

 
 

 
 
 
 
 
 
Tool Setting Effect 

Method 

Sets the method. 

• Active Scale — Scale by the active scale factors (X Scale and Y Scale). If a scale factor 
is 0-1 (for example, 0.25), size in that direction is decreased; if a scale factor is greater 
than 1, size in that direction is increased. 

• 3 Points Scale — Scale graphically, through the entry of three data points. The scale 
factors are computed by dividing the distance between the first and third points by the 
distance between the first and second points. 

X Scale Scale factor along view x-axis (horizontal), when Method is Active Scale. 
Y Scale Scale factor along view y-axis (vertical), when Method is Active Scale. 

Attach Copy Toggle ON to create a new attachment. 
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To scale an image using Active Scale: 
 

1. From the Raster Control toolbox, select Scale Raster tool. 
 

2. Choose Active Scale from the Method option menu. 
 

3. Specify the scale by entering a factor in the Scale input box.  
 

4. Enter a data point that remains at the same location, whatever the scale. All views where the image is 
displayed update to reflect your scale adjustments. 

 
To scale an image using 3 Points Scale: 
 

1. From the Raster Control toolbox, select Scale Raster tool. 
 

2. Choose 3 Points Scale from the Method option menu. 
 

3. Enter a data point that remains at the same location, whatever the scale. 
 

4. Enter a second data point at a known location on the image. A cursor is placed where the data point 
was entered and a dynamic rectangle outlining the image appears. 

 
5. Move the cursor so that the image outline increases or decreases to reflect the scale factor. Enter a 

data point to confirm/accept the new scale. This data point can be entered in any open view. When 
you move the cursor, observe that the image outline decreases until it reaches a minimum size and 
then increases again. 

 
 
 
4.5 Rotate Raster tool 
 
 
Used to rotate an image. Multiple selections are allowed. All the selected images are rotated 
 

The Rotate Raster tool cannot be used on rasters which have their "Apply Rotation and Affinity to R
toggle set to OFF. 

aster" 

 

            
 
 

When using the Rotate Raster tool, you are able to snap to tentative points on an element. The 
AccuSnap mode is enabled when MicroStation Descartes is installed.  
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Tool Setting Effect 

Method 

Sets the method used to rotate. 

• Active Raster — the raster is rotated by the angle value, which can be keyed in or 
selected. 

• 2 Points Rotate — the angle of rotation is defined by entering two data points. 

• 3 Points Rotate — the angle of rotation is defined by three data points. 

Attach Copy Toggle ON to create a new attachment. 
 
 
To rotate an image to a specified angle: 
 

1. From the Raster Control toolbox, select Rotate Raster tool. 
 

2. Enter a data point to define the pivot point. 
 

3. If Method is set to Active Rotate, enter the wanted angle value. The arrows will increase or decrease 
by 90 degrees at a time. Otherwise, continue with step 4. 

 
4. If Method is set to 2 Points Rotate, enter a data point to define the angle of the rotation. Or if Method is 

set to 3 Points Rotate, enter a data point to define the start of the rotation. If Method is set to 2 Points 
Rotate, the raster is rotated; repeat to rotate the raster again. Otherwise, continue with step 5. 

 
5. Enter a data point to define the angle of the rotation. 

 
 
 
 
 
4.6 Mirror Image tool 
 
 
Use the Mirror Image tool to flip the source image using a horizontal, vertical, or diagonal mirror. The image is 
transformed and can either replace the current file or is copied to a new file. Multiple selections are allowed. All 
the selected images are mirrored. 
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Tool Setting Effect 

Mirror About 

Lets you choose, via an option menu, how to mirror the raster image. 

• Horizontal — Mirrors the selected image about a horizontal axis. 

• Vertical — Mirrors the image about a vertical axis.  

• Line — Mirrors the image about a user-defined line.  

Mirror Position 

Lets you define the mirror position, via an option menu. 

• Dynamic  

• Image(s) Center  

• Images Extent Center  

Attach Copy Toggle ON to create a new attachment. 
 
 
To mirror an image using the transformation matrix 
 

1. From the Descartes Raster Control tool box, select Mirror Image.  
 

2. By default, the Attach Copy toggle is turned OFF in the tool settings 
window. This allows you to take advantage of the speed of the 
transformation matrix. If you wish to create a new attachment of the 
image, select Attach Copy. 

 
3. Choose a data point on the image to mirror. 

 
To reverse an image using a mirror creating a new output image 
 

1. Select Mirror Image tool. 
 

2. In the tool settings window, turn ON Attach Copy and select the appropriate options for the mirroring 
direction and position. 

 
3. Position the image outline in the view. 

 
4. Enter a data point. 

 
 
 
 
4.7 Square Image tool 
 
 
Select Square Image to rotate a raster image by squaring a horizontal, vertical, or diagonal axis. Multiple 
selections are allowed. 
 
The default settings assumes you will use the transformation matrix, but it is possible to resample the image 
by checking the “Attach Copy” toggle box which appears in the Square tool setting. 
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To square an image 
 

1. From the Raster Control tool box, select Square Image. 
The tool settings window opens.  

 
2. By default, the Attach Copy toggle is turned OFF in the tool settings 

window. This allows you to take advantage of the speed of the 
transformation matrix. If you wish to create a new attachment of the image, 
select Attach Copy. 

 
3. Select a data point on your image. 

 
4. Choose two points on the appropriate axis and the image will be squared. 

 
 
 
4.8 Merge/Crop Image tool 
 
 
Use the Merge/Crop Image tool to merge or crop one or more images contained within a defined area. Multiple 
selections are allowed. 
 
The Merge function applies to all the displayed rasters while the Crop function applies only to the selected 
rasters. 
 
A new raster file is created when using the Merge tool only.  
 
The Crop tool modifies the original raster file by removing the data outside the specified area on the selected 
rasters. With multiple selections, the Crop action will be applied on each selected image that is touched by the 
specified area. 
 
The Merge function is WYSIWYG, meaning that contrast, brightness, gamma correction and more will be 
applied before the new image is created. 
 
If images included in the input area are displayed in a mosaic where Transparency has been used, the output 
file contains all pixels visible in the input area. Therefore, the output file will be one uniform file that no longer 
requires the Transparency settings to display the mosaic area. 
 
 
 
 
 
 
 
 
To merge images contained within a block 
 

1. Select Merge/Crop Image tool. 
The tool settings window displays. 

 
2. Select Merge from the Action option menu and Block from the Area option menu. 

 
3. Enter a data point to fix the origin of the input area (block). 

As you move the cursor, a dynamic rectangle appears.  
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4. Enter a data point to fix the opposite corner.  
When the Warp to Area toggle is enabled, no matter in which order the data points are entered, the 
lower left corner of the block will always be considered as the origin and the lower right corner of the 
block will define the angle. If the view as no rotation, the `´Block´´ area will always have an angle of 
zero. 
You can enter the data point in any view. If there is no image in the area defined by the rectangle, an 
error message displays. Otherwise, the Merge Options dialog box displays. 

 
5. In the Merge Options dialog box, enter the Output Image Name and select the resampling options and 

resolution parameters, then click Run. 
The output image is added to the list of the view in which the origin was entered. The view then 
updates. 

 
 

When an output file is created with the Raster Control tools, the background color displays in all areas 
not occupied by the target input region. If you do not wish the background color to be displayed in a 
given view, turn on the Transparent and/or the Clipping toggle in the Merge Options dialog box. 

 
 

 
 
 
 
To merge images contained within an oriented block 
 

1. Select Merge/Crop Image tool. 
 

2. Select Merge from the Action option menu and Oriented Block from the Area option menu. 
 

3. Enter a data point to fix the origin of the area (block).  
A rubber band appears as you move the cursor. Enter a secont data point to set the angle of the 
oriented block. 

 
4. As you move the cursor, a dynamic rectangle appears. Set the resampling rectangle by entering a 

third data point in the appropriate direction to fix the opposite corner.  
When the Warp to Area toggle is enabled, no matter in which order the data points are entered, the 
lower left corner of the block will always be considered as the origin and the lower right corner of the 
block will define the angle. If the view as no rotation, the `´Block´´ area will always have an angle of 
zero. 
You can enter the data point in any view. The orientation is defined by an angle calculated from the 
design plane positive x-axis. If there is no image in the area defined by the rectangle, an error 
message displays. Otherwise, the Merge Options dialog box displays. 

 
5. In the Merge Options dialog box, enter the Output Image Name and select the resampling options and 

resolution parameters, then click Run. 
The output image is added to the list of the view in which the origin was entered. The view then 
updates. 
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When an output file is created with the Raster Control tools, the background color displays in all areas 
not occupied by the target input region. If you do not wish the background color to be displayed in a 
given view, turn on the Transparent and/or the Clipping toggle in the Merge Options dialog box. 

 
 

 
 
 
 
To crop images contained within a block 
 

1. Select Merge/Crop Image tool. 
The tool settings window displays. 

 
2. Select Crop from the Action option menu and Block from the Area option menu. 

The tool settings box expands to allow you to enable or disable the Transparent and Clipped toggles. 
When the Transparent toggle is enabled (default), transparency will automatically be applied to the 
output image. When the Clipped toggle is enabled (the default) the clipping will be applied to the 
output image. 

 
3. Enter a data point to fix the origin of the input area (block). 

As you move the cursor, a dynamic rectangle appears.  
 

4. Enter a data point to fix the opposite corner.  
The original raster file is modified by removing the data outside the specified area. 

 
 
 
To crop images contained within an oriented block 
 

1. Select Merge/Crop Image tool. 
The tool settings window displays. 

 
2. Select Crop from the Action option menu and Block from the Area option menu. 

The tool settings box expands to allow you to enable or disable the Transparent and Clipped toggles. 
When the Transparent toggle is enabled (default), transparency will automatically be applied to the 
output image. When the Clipped toggle is enabled (the default) the clipping will be applied to the 
output image. 

 
3. Enter a data point to fix the origin of the area (block).  

A rubber band appears as you move the cursor. Enter a secont data point to set the angle of the 
oriented block. 

 
4. As you move the cursor, a dynamic rectangle appears. Set the resampling rectangle by entering a 

third data point in the appropriate direction to fix the opposite corner. 
The original raster file is modified by removing the data outside the specified area. 
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To crop images inside an element 
 

1. Select Merge/Crop Image tool. 
The tool settings window displays. 

 
2. Select Crop from the Action option menu and Block from the Area option menu. 

The tool settings box expands to allow you to enable or disable the Transparent and Clipped toggles. 
When the Transparent toggle is enabled (default), transparency will automatically be applied to the 
output image. When the Clipped toggle is enabled (the default) the clipping will be applied to the 
output image. 

 
3. Click on the target polygon. Enter a data point to accept the element.  

When the Warp to Area toggle is enabled, the first two points of the shape that defines the area will 
determine the angle of the area.  
You can enter the data point in any view. If there is no image in the area defined by the rectangle, an 
error message displays. Otherwise, the Crop Options dialog box displays to permit you to set the 
resampling parameters. 

 
4. In the Crop Options dialog box's Options field, choose the crop options, then click Run to resample the 

image. 
The original raster file is modified by removing the data outside the specified area. 

 
 

 
The Crop function is not allowed on images with the Apply Rotation and Afiinity option turned 

OFF. For Merge operations, the backfill is set to the MicroStation view's background color. For Crop 
operations, each raster will keep its backfill color. The Fence mode is not supported. The Crop 
function is not supported with References or with read-only images.  
 
 
 
4.8a Merge Options dialog box 
 
Used to determine the characteristics of the output file created with the Merge Images tool. 
 

 
 
Output File Name 
 
Used to specify the name for the output file. A default file name will be generated following the same rules as 
in the old versions of Bentley Descartes. The magnifying glass opens the Select Raster File dialog. It now 
accepts all the supported file types. The compression and the file type are selected in this dialog.  
 
 
Options 
 
Use these toggles to preset features in the output image. 
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Transparent When enabled (default), transparency will automatically be applied to the output image.  

Warp to 
Area

When enabled, the raster’s header or sister file will be modified to match the source element’s 
origin and rotation.  

When disabled (the default), this option will invoke the Merge function without resampling the 
rotation. The image will not have any transformation (rotation affinity) stored in its header or 
sister files.  

Clipped When enabled (the default) the clipping will be applied to the output image. 
 
 
 
 
Resolution 
 
The Resolution parameters are used to adjust the output image. Each field and option is described below. 
 

Based 
On 

The user can select the default output pixel size. The available options in the “Based On” option 
button are: 

• One entry with the name of each touched image: The output pixel size can be set to the 
pixel size of any of the input images. 

• Average: The output pixel size can be set to the average pixel size (or scale factor) of the 
selected images. 

X and Y The “X” and “Y” fields can be edited. 

Reset If the Reset button is used, the X and Y values will be reset to their original values. The original 
values are determined by the “Based On” option. 

 
 
 
Run 
 
Click Run to create the output image. While the image is being created, a Progress indicator displays.  
 
If there is not enough space on the destination disk to contain a file that will be compressed, you are warned 
and permitted to cancel the process. If you chose not to compress the output file and if there is not enough 
space on the destination disk, you are warned that the process cannot be performed. 
 
 
 
Cancel 
 
If you decide not to use the present parameters, click Cancel. The dialog box then closes. 
 
 
 
 
4.9 Corridor Image tool 
 
 
Use the Corridor Image tool to copy the regions of one or more images contained within a polygon to an output 
polygon of the same shape. The copied regions of the source images are merged into a new image and then 
copied to the output space defined by the polygon. Design elements (from the design file and associated 
reference files) that occupy the region contained within the polygon can also be copied to the output polygon. 
Multiple selections are allowed. 
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The Corridor Image function is now WYSIWYG, meaning that transparency, contrast, brightness, gamma 
correction and more will be applied before to new image is created. 
 
When you use Corridor Image, both the input (source) and output (destination) polygons must be the same 
shape (usually a copy of the same element). However, the output polygon can be rotated, scaled, and moved 
to reflect the desired output result. 
 
If the images in the input area are displayed with transparency to make a mosaic, the output file will contain all 
of the pixels that you can see, not the transparent parts. Therefore, the output file will be one uniform file that 
no longer requires the transparency settings in order to display the mosaicked area. 
 

 
 

The Corridor Image tool creates an image using other images  
 
To use Corridor Image 
 

1. Create a source and destination polygon. 
 

2. Place the source polygon on the target region that you want to copy. 
 

3. Select the Corridor Image tool. 
 

4. Click on the source polygon and enter a data point to accept the element.  
 

5. Click on the destination polygon. Enter a data point to accept the element.  
The Corridor Option dialog box displays to allow you to set the resampling parameters and to select 
the name of the output file. 
The output image is added to the file list for the view where you selected the output destination 
polygon. The view then updates. 

 
 

The polygon must be a shape or complex shape, which contains only lines, and line strings. If a complex 
shape is used and it contains more than 100 points, then the Copy Design Elements feature is disabled. 

 
 

When an output file is created with the Raster Control tools, the background color displays in all areas 
not occupied by the target input region. If you do not wish the background color to be displayed in a 

given view, turn on the Transparent toggle in the Output Settings dialog box and the Transparency toggle in 
the View Image Attributes dialog box for this view. 
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4.9a Corridor Options dialog box 
 
Used to determine the characteristics of the output file 
created with the Corridor Image tool. 
 

 
 
Output File Name 
 
Use to specify the name for the output file. A default file 
name will be generated following the same rules as in the 
old versions of Bentley Descartes. The magnifying glass 
opens the Select Raster File dialog. It now accepts all the 
supported file types. The compression and the file type are 
selected in this dialog.  
 
 
Options 
 
The Transparent and Clipped toggles can be turned ON to preset these features in the output image. Upon 
completion of the corridor operation, Raster Manager will automatically attach the new image and, if turned on, 
the display options will automatically be applied.  
 
 
Output Image Parameters 
 
These parameters are used to adjust the output image. Each field and option is described below. 
 
 

Keep Image 
Density Conserve the source image's density in the output image. 

Based On 

The user can select the default output pixel size. The available options in the “Based On” 
option button are: 

• One entry with the name of each touched image: The output pixel size can be set to 
the pixel size of any of the input images. 

• Average: The output pixel size can be set to the average pixel size (or scale factor) of 
the selected images. 

X and Y The “X” and “Y” fields can be edited. 

Reset If the Reset button is used, the X and Y values will be reset to their original values. The 
original values are determined by the “Based On” option. 

Model 

Select the model to use for the Corridor operation. The available models are: 

• Align (Move, Scale) 
• Helmert (Move, Rotate) 
• Similitude (Move, Scale, Rotate) 
• Affine (Move, Scale, Rotate, Skew) 
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4.10 Clip tool 
 
 
Used to clip a raster image (Clip Boundary), or to define a masked area (Clip Mask). An image can have one 
clipping boundary, but may have a number of clipping masks. Thus, when you create a new clipping boundary, 
any existing clipping boundary is cleared. When you create a clipping mask, however, it is added to any 
existing clipping masks for the selected image. 
 
Multiple selections are allowed when using the Clip tool. However, when more than one image is selected, the 
clipping will not create one single polygon, but as many different clipping polygons as there are images. If the 
Modify Clip tool is subsequently used, and only one image is selected, only the clipping polygon associated to 
this single image will be modified and not all the clipping polygons as a whole. 
 
 
 
 
 
 
 
 
Tool Setting Effect 

Method 

This option menu lets you choose the type of Method to be used to clip the raster image. 

• Element — Lets you specify an existing (closed) element in the design file to use as a 
clipping polygon. 

• Fence — Lets you use an existing fence as a clipping polygon. 

• Block — Lets you interactively draw a block to be used as a clipping polygon. 

Mode 

This option menu lets you choose the clipping mode that is used to clip the raster image. 

• Clip Boundary — Used when cropping images. The image is cropped back to the limits 
of the clipping object. 

• Clip Mask — Used to mask a section within a raster image. This option lets you place a 
text box, for example, within a raster image file. 

 
 
To clip a raster image using an element to define the boundary 
 

1. Draw the element to define the clipping boundary.  
 

2. Select the Clip tool. 
 

3. In the tool settings window, set Method to Element and Mode to Clip Boundary. 
 

4. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

5. Identify the clipping element. 
 

6. Accept the element as the clipping polygon to clip the image. 
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To clip a raster image using a fence to define the boundary 
 

1. Place a fence to define the clipping boundary.  
 

2. Select the Clip tool.  
 

3. In the tool settings window, set Method to Fence and Mode to Clip Boundary. 
 

4. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

5. Accept the fence as the clipping polygon to clip the image. 
 
 
 
To clip a raster image using a block to define the boundary 
 

1. Select the Clip tool.  
 

2. In the tool settings window, set Method to Block and Mode to Clip Boundary. 
 

3. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

4. Enter a data point to define the first point of the block. 
 

5. Enter a data point to define the opposite corner of the block. 
 

6. Accept the block as the clipping polygon to clip the image. 
 
 
 
To mask an area of a raster image using an element to define the boundary 
 

1. Draw the element to define the mask boundary.  
 

2. Select the Clip tool. 
 

3. In the tool settings window, set Method to Element and Mode to Clip Mask. 
 

4. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

5. Identify the clipping element. 
 

6. Accept the element as the clipping polygon to mask part of the image. 
 
 
 
To mask part of a raster image using a fence to define the boundary 
 

1. Place a fence to define the clipping boundary.  
 

2. Select the Clip tool.  
 

3. In the tool settings window, set Method to Fence and Mode to Clip Mask. 
 

4. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

5. Accept the fence as the clipping polygon to mask the image. 
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To mask part of a raster image using a block to define the boundary 
 

1. Select the Clip tool.  
 

2. In the tool settings window, set Method to Block and Mode to Clip Mask.  
 

3. If more than one raster image is attached to the design file, identify the raster image to be clipped. 
 

4. Enter a data point to define the first point of the block. 
 

5. Enter a data point to define the opposite corner of the block. 
 

6. Accept the block as the clipping polygon to mask the image. 
 
 
 
 
 
4.11 Modify Clip tool 
 
 
Used to modify the clipping polygon for a clipped raster image. 
 
Multiple selections are allowed when using the Clip tool. However, when more than one image is selected, the 
clipping will not create one single element, but different clip elements. If the Modify Clip tool is subsequently 
used, and only one image is selected, only the clip element associated to this single image will be modified 
and not all clip elements as a whole. 
 
 
 
 
 

Tool Setting Effect 

Update After Each 
Modification 

If ON, the raster image updates after each modification to the clipping polygon. 

If OFF, no modification is made to the display of the raster image until modifications to 
the clipping polygon are completed and you enter a Reset. 

 
 
 
To modify a clipping polygon without automatic updating 
 

1. Select the Modify Clip tool. 
 

2. In the tool settings window, turn off Update After Each Modification. 
 

3. Identify the raster image. 
 

4. Identify the clipping polygon to modify at the point to be modified. 
 

5. Make the modification. 
 

6. (Optional) Repeat steps 4 and 5 for any further modifications that are required. 
 

7. Enter a Reset to complete. 
The raster image updates to reflect the modifications to the clipping polygon. 
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To modify a clipping polygon with automatic updating 
 

1. Select the Modify Clip tool. 
 

2. In the tool settings window, turn on Update After Each Modification. 
 

3. Identify the raster image. 
 

4. Identify the clipping polygon to modify, then drag the polygon's outline to modify it. 
 

5. Make the modification. 
The raster image updates to reflect the modification to the clipping polygon. 

 
6. (Optional) Repeat steps 4 and 5 for further modifications. 

 
 
 
4.12 Unclip tool 
 
 
Used to remove one or more clipping polygons from a raster image. You can select the raster image 
graphically after selecting the Unclip tool. Alternatively, you may select the raster image first, via the Raster 
Manager dialog box or with the Select Rasters tool. 
 
 
 
 
 
 
Tool Setting Effect 

Delete 

Lets you choose between deleting all polygons in one step, or selected polygons. 

• All Polygons — Lets you delete all clipping polygons associated with a raster image. 

• Selected Polygon — Lets you choose the clipping polygons that you want to delete from 
a raster image. 

 
 
 
To delete all clipping polygons from a raster image 
 

1. Select the Unclip tool. 
 

2. In the tool settings window, set Delete to All Polygons. 
 

3. Identify the raster image from which the clipping polygons are to be removed. 
The clipping polygons for the selected raster image are highlighted. 

 
4. Accept to delete all the clipping polygons. 

 
 
To delete selected clipping polygons from a raster image 
 

1. Select the Unclip tool. 
 

2. In the tool settings window, set Delete to Selected Polygon. 
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3. Identify the raster image from which the clipping polygons are to be removed. 
The clipping polygons for the selected raster image are highlighted. 

 
4. Identify a clipping polygon to delete. 

The selected clipping polygon highlights in a different color. 
 

5. Accept to delete the clipping polygon. 
 

6. (Optional) Repeat steps 4 and 5 to remove other clipping polygons from the selected image. 
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5.0 Registering Images and Vector Data 
 
This chapter describes the Register utility and all the related features. Register is used to geometrically correct 
images or vector data to a given coordinate system by warping them to fit a reference or base document. The 
base document can be an image, a vector file, a drawing, a map sheet, or a list of known points. 
 
 
Warping Images with Register 
 
Register provides more control on establishing the transformation models and gives access to more 
sophisticated features, such as: 
 

• Dynamic warping which overlays existing vector data over the uncorrected image, so you can verify 
the actual transformation model and decide whether it is good enough for running the resampling of 
the image.  

 
• More flexibility for entering and managing control points. Any control point can be moved or deleted.  

 
• Polynomials models which can be used for more severe distortion. 

 
• A No-Residual Transformation model for precision in control points. 

 
• Any number of control points. When there are more Dynamic Warping in Views Displaying 

Uncorrected Data than the minimum required, residuals can be used for inspecting and analyzing the 
actual model. 

 
• Transformation of vector data through the same model. 

 
• Batch resampling of images. 

 
 
Transformation Models 
 
Various warping transformation models are supported:  
 

• Helmert 
 

• Similitude 
 

• Affine 
 

• Projective 
 

• Thin Plate Spline - No Residuals 
 

• Polynomial 
 
The unique design of Register lets you to visually determine if the transformation model is accurate. Since 
base vector data is displayed over the target image, it is simple to identify inaccuracies in the model. To assist 
you in the warping process, Register displays statistical information about the accuracy of the transformation 
model. You can also dynamically change the transformation model and interactively edit the control points on 
the base document.  
 
When the transformation model is accurate, as many images as necessary can be resampled. Resampling 
methods include nearest neighbor, bilinear interpolation, and cubic convolution.  
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Concepts 
 
Registering images or vectors requires that their geometry be altered to fit another geometry taken as a 
reference. The process consists of two steps. First, a transformation model is built. Second, the images or 
vectors are resampled through this transformation model. 

 
Throughout this chapter, the terms base and uncorrected are used with a very specific meaning:  
 

The base is the system of coordinates taken as a reference and onto which the uncorrected data is registered. 
The base can be vectors, digital images, hard copy, a series of known points, or some other geometric source.  
 
The uncorrected data is a digital document targeted to fit the base after it is transformed through a 
mathematical model. 
 
 
 
Building a Model 
 
Building a model requires that a set of mathematical functions be built to establish correspondence between 
any point in the base geometry and the corresponding point in the target geometry. 
 
The way that Register establishes this set of functions is by placing a set of corresponding points, called 
control points, and interpolating for the remainder of space around the control points. The control points are 
represented by color marks in both base and uncorrected spaces. The interpolation is done with smooth two-
dimensional functions like Helmert, Affine, Similitude, Projective, and up to a third degree Polynomial. 
 
To test the accuracy of the interpolation, Register warps a representation of the base vector data to fit the 
uncorrect data. This visualization illustrates the fit that occurs when you resample the uncorrect data to fit the 
base data. 
 
This visual feedback assists you as you gather more points and improve the fit. After enough points are 
gathered to satisfy the requirements of the selected transformation model, the uncorrect image or vectors can 
be resampled using this model. Since the fit has already been determined visually, the result is “what you see 
is what you get” resampling. 
 
Warping the base vector data is done dynamically and is normally fast. It is recommended that you warp a 
small but significant set of base vector data. The set of base vector data can be acquired by extraction from 
one or several base documents, in digital or analog formats: design files, digital images, analog maps, 
drawings, plans, lists of known points, and so forth. 
 
With a design file, extract a few representative elements or parts of elements. With a digital image, extract a 
few representative elements by interpretation. With a hard copy document, digitize a few representative 
elements. With a list of known points, no base vector data set is needed to use the dynamic warping capability 
since the control point marks play this role. 
 
You can also use Register to build a model without a set of base vector data and without dynamic warping, 
which resembles the method that is commonly used with most geometric correction software. However, with 
this method there is no means to test the accuracy of the model prior to resampling the image or vector file. 
 
Another unique feature of Register is the alleviation of the constraint of finding “true” or “exact” control points. 
With Register, you can use “fuzzy” control points, because of the visual feedback provided by dynamic 
warping. 
 
A true or exact control point is a point which can be precisely identified on both the base data set and on the 
data to be registered. Examples include the crossing of two roads, the corner of a part, the corner of a 
building, and so forth. A fuzzy control point is a point which can be localized approximately on both 
documents. Examples include the center of a lake, window, or field, or the top or side of a car, and so forth. 
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When you use fuzzy control points, pick each point approximately in the base space and pin it in the 
uncorrected space by determining its general position. The dynamic warping shows if your placement is 
accurate enough. If not, just move the point. 
 
 
Image Resampling 
 
The image resampling process creates a new image, pixel by pixel, by establishing an appropriate value for 
each pixel. The resulting image is similar to the one from which it is calculated, with a very close radiometry 
and with a slightly different geometry. 
 
There are two steps in the image resampling process: 
 

• For each pixel of the output image, the first step is to find the corresponding point in the input image by 
passing it through the established transformation model.  

 
• The second step is to calculate the value of the output pixel by using the value of one or several pixels 

located on or around the corresponding point in the input image.  
 
The Nearest Neighbor algorithm uses only one input pixel. Bilinear Interpolation uses the four nearest 
neighbors and calculates the weighted mean. Cubic Convolution uses a four by four matrix of pixels and 
calculates a type of weighted mean.  
 
The Nearest Neighbor algorithm is faster, but it can cause jagged edges or lines on the output image. The 
Cubic Convolution algorithm takes longer, but the result is much smoother. The Bilinear Interpolation is a 
compromise between the other two methods in both speed and image quality.  
 
The image resampling process can be independent of the process of building a model with control points. It is 
used with various other kinds of models such as translations, rotations, and scale changes, or even with a 
neutral model used only to cut images into pieces or to change the resolution of images. A set of standard 
models is provided with Bentley Descartes.  
 
Image Resampling can also be done dynamically by choosing to use the transformation matrix of the image. 
This process is achieved simply by turning OFF the Create a New Image option from the Register dialog. 
 
 
Vector Resampling 
 
The vector resampling process copies or moves the selected design elements through the transformation 
model. The design elements are selected from the master file or from any reference file by using a fence or a 
selection set. You control whether each design element type will be considered or ignored by the 
transformation model. This flexibility is useful when processing many elements. 
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5.1 Register tool box 
 
 
This tool box provides access to tools you can use to place, move, or delete control points, to copy or move 
vectors through the actual model, or to prepare the resampling of the actual image. The last button opens the 
Register dialog box, but it does not need to be open to use the other tools. 
 
 
Place Control Points tool 
 
Place a new pair of control points 
 
 
 
Move Control Point tool 
 
Move an existing control point mark. 
 
 
 
Delete Control Points tool 
 
Remove an existing pair of control points from the control points list box. 
 
 
 
Register Dialog tool 
 
Open the Register dialog box. 
 
 
 
Resample Image tool 
 
Open the Resampling dialog box and quickly prepare a fresh resampling page by setting all parameters with 
default values. 
 
 
 
Resampling Dialog tool 
 
Open the Resampling dialog box. 
 
 
 
Copy Vector tool 
 
Copy vectors through the active transformation model. 
 
 
 
Move Vector tool 
 
Move vectors through the active transformation model. 
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5.2 Place Control Points tool 
 
Click the Place Control Points tool to place a new pair of control points.  
 
The resulting pair of control points then displays in the control points list box in the Register dialog box, with 
the status set to on. The pair is inserted just after the previously selected line and the new line is now selected 
(highlighted). If Dynamic Warping in Views Displaying Uncorrected Data is on, the model updates and the 
base vector data warping updates in the specified views.  
 
After a model is updated, the distance between the two corresponding marks reveals the residual for this pair 
of control points. As long as there are no extra points, the model is exact, i.e., there is no residual. 
Consequently, the two corresponding marks of each pair coincide. 
 
 
To place control points 
 

1. Select Place Control Points.  
 

2. Move the base control point mark to the desired place relative to the base data.  
 

3. Pin the base control point mark.  
 

4. Move the uncorrected control point mark to the corresponding place on the uncorrected data.  
 

5. Pin the uncorrected control point mark. 
 

 
 

Placing Control Points 
 
 
 
5.3 Move Control Point tool 
 
Click the Move Control Point tool to move an existing control point mark.  
 
The line in the list box corresponding to the modified control point is now selected (highlighted) and is rewritten 
with the adjusted coordinates. If Dynamic Warping in Views Displaying Uncorrected Data is on, the model 
updates and the base vector data warping refreshes in the specified views.  
 
After a model is updated, the distance between the two corresponding marks indicates the residual for this pair 
of control points. As long as there is no extra point, the model is exact, i.e., there is no residual. Consequently, 
the two corresponding marks of each pair coincide. 
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To move a control point 
 

1. Select Move Control Point.  
 

2. Identify an existing control point mark (a base control point mark or an uncorrected control point mark).  
 

3. Accept the control point mark, or reject and retry.  
 

4. Move the control point mark to the desired place relative to the base or to the uncorrected data.  
 

5. Pin the control point mark.  
 
 
 
5.4 Delete Control Points tool 
 
Click the Delete Control Points tool to remove an existing pair of control points from the control points list box.  
 
When the identified point is accepted, both marks that belong to this pair are deleted and the corresponding 
line is removed from the list box. The rest of the list is renumbered. If Dynamic Warping in Views Displaying 
Uncorrected Data is on, the model updates and the base vector data warping refreshes in the specified views. 
 
After a model is updated, the distance between the two corresponding marks reflects the residual for this pair 
of control points. As long as there are no extra points, the model is exact, i.e., there is no residual. 
Consequently, the two corresponding marks of each pair coincide. 
 
 
To remove (delete) a pair of control points 
 

1. Select Delete Control Points.  
 

2. Identify an existing control point mark, whether it is a base control point mark or an uncorrected control 
point mark.  

 
3. Accept the control point mark, or reject and retry. 

 
 

Only the points turned on can be deleted with the Delete Control Point tool, since the points turned off 
are not marked. If you want to toggle points on or off, double-click on the corresponding line.  
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5.5 Register dialog box 
 
 
Access the Register dialog box by choosing Register from the Utilities menu of Raster Manager, or by 
selecting the Register dialog button from the Register tool box.  
 
 
 
 
 
 
 
The title bar of the Register dialog box displays the name of the current model. If a model is not opened or if 
the current model has not been given a name, "Untitled" displays as the file name. 
 
 

 
 
 
Model Selected 
 
Use the Model Selected option menu to select the type of model. The Actual Model field provides feedback on 
the actual model that can be calculated from currently captured control points.  
 
The control points used to control the building of a model are displayed below the menu bar of the dialog box 
and the Model Selection area.  
 
This information provides feedback to assist you in the building of a model with control points. It includes nine 
columns, which contain the number of a control point, its on/off status, its X and Y coordinates in the base and 
uncorrected system, and its residuals relative to the actual model. 
 
 

A model built with Register is a set of equations that define the correspondence between a point in the 
uncorrected system of coordinates and the equivalent point in the base system of coordinates. 

 
 
The minimum number of required control points is indicated for each model in the following list: 
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The Helmert model 
 
The Helmert model, also called “rigid body,” performs a rotation and two translations (X and Y); however, no 
scaling is done. This model guarantees that the uncorrected data retains its proportions since the image or 
design elements are only moved and rotated. 
 

 
 
 
 
 
The Similitude model 
 
The Similitude model performs a rotation, two translations (X and Y), and a scaling that has the same factor for 
the x- and y-axis. You can use a Similitude model to cut an image, to rotate an image, or to register two 
images with the same deformation relative to each other. 
 

 

 
 
 
 
 
The Affine-1 model 
 
The Affine-1 performs a rotation, two translations (X and Y), and applies a different scale factor for the x-, y-
axis as well as a factor that changes the orthogonality of these axes. You can use the Affine-1 model to 
register a document that has very little deformation such as a scanned map.  
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The Projective model 
 
The Projective model projects one plane into another plane. Like the Similitude and the Polynomial-1 models, 
it can be used to register a document that has very little deformation. For example, you can use it to register 
an aerial photograph that has little relief. 
 

 
 
 
Thin Plate Spline mode 
 
The Thin Plate Spline model is based on a four variable mathematical algebraic formula. This means that this 
model requires at least four pair of control points to resolve the transformation model. 
 
The benefits of this model resides in the fact that in order to compensate for the distortion caused by the 
rubbersheeting, instead of moving the control points to accommodate the residual values as in the traditional 
models, the Thin Plate Spline does not move the control points but instead, applies a correction elsewhere 
around the control points. 
 
The trade-off is where it will most often be required to enter more control points than a traditional model. 
Control points will be positioned where the two systems (correct and uncorrected) do not aligned. Control 
points must be entered until the tanglement is satisfactory. 
 
 

The Polynomial-2 and 3 models 

The Polynomial-2 and 3 models are used to register documents that have moderate relief. However, they are 
not suitable for documents that contain accentuated relief. For example, you can use these models to register 
aerial photographs of a city with low hills, but should not use these models to register aerial photographs of a 
mountainous region. 

 

Actual Model 

When there are not enough points to build the requested model, a provisional model, needing less points, is 
calculated to support the dynamic warping.  

When the minimum number of points is reached for the model requested, the Actual Model field displays the 
same name as the Selected Model option menu. If Dynamic Warping in Views Displaying Uncorrected Data is 
on and for any reason the model cannot be calculated with the present set of control points, the actual model 
shown is None. 
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Control Point # 

The Control Point # column provides a sequential number for all control points entered. If a point is removed or 
if a new point is inserted between two existing points, the list renumbers. 

On 

The On column indicates whether the corresponding control point is on or off in the calculation of the actual 
model. An "X" indicates on. An empty space indicates that this point is turned off. Double-clicking a line of the 
list toggles the status of the corresponding control point between on and off.  

Base System X, Y 

The X and Y columns under Base System display the coordinates of control points in the “base” system of 
coordinates. This system is the one into which the image is to be transformed after it is resampled by applying 
the model. 

Uncorrected System X, Y 

The X and Y columns under Uncorrected System display the coordinates of control points in the “uncorrected” 
system of coordinates. The residual of a control point is the difference in location between the position where a 
control point is pinned on the uncorrected system as compared to the position it should be according to the 
actual model. When a model is built with the minimum number of control points, such as four points for the 
Projective, there is no residual (except for Helmert). This situation means that the model “trusts” you and puts 
the calculated point exactly where you pinned it on the uncorrected system.  

In fact, since the model has only the minimum number of points, it must make this assumption. As soon as an 
extra point is provided, it can compare the position you “guessed” with the position it calculates through the 
model. The difference between your “guess” and the calculated position is the residual.  

After a model is updated, the distance between the two corresponding marks reveals the residual for this pair 
of control points. As long as there is not an extra point, the model is exact, i.e., there is no residual (except for 
Helmert). Consequently, the two corresponding marks of each pair coincide. 

The model supported is always the best fit to all points, when extra points are provided. Normally, when a 
control point is inconsistent with the others, its residual is greater. The residuals displayed in the Control Points 
List box are indications of points that can need adjustment. Turning off the point with the greatest residual 
normally improves the actual model.  

Residuals are distances. The three columns X, Y, and XY under Residuals indicate the X component, the Y 
component, and the magnitude (XY) of this distance.  

The Helmert model differs from the other models in respect to residuals. Because this model guarantees that 
the body of the uncorrected geometry stays rigid (without scale modification), the minimum number of control 
points usually generates residuals. In fact, with two control point pairs, the Helmert model moves and rotates 
the rigid body until the residuals are minimized.  

Residuals 

Used to specify whether the calculated and displayed residual values apply to the Base System or to the 
Uncorrected System. 

On/Total  

The On/Total field displays the number of control points turned on over the total number of control points in the 
present list. 
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File > Save As 

It is now possible to save a register list of control points into a text file. To do so: 

1. Open an existing RGR file or create one. 
2. From the Register dialog box, select File>Save As. 

The Save Model dialog box opens. 

3. In the Select Format To Save option menu, select “Text (Comma delimited) [*.txt]” 
4. Enter a file name and a location folder. 
5. Click OK 

The resulting file can be opened in a text editor or imported in a spreadsheet application supporting Comma 
Delimited file formats. 

Edit menu 

The Edit menu provides access to various tools and dialog boxes that are used to create or modify a model. 
Use these features to enter, modify, delete, highlight, or locate pairs of control points, and to identify the 
coordinate system to which the base data belongs.  

Edit > Add Control Points 

Choose Add Control Points from the Edit menu to manually enter a pair of control points: (Base X, Base Y) 
and (Uncorrected X, Uncorrected Y).  

The On/Off check button toggles this pair of points between on or off. When on, the pair of points is taken into 
account for the calculation of the actual model and the corresponding marks display in the appropriate views. 
When off, this pair is suppressed and the marks are not shown. The points, however, can be turned on and 
used again by using the Modify Control Points dialog box.  

The new pair of points is always added after the previously selected line. If the new line is inserted before the 
last existing line, a renumbering of the following lines results.  

In some situations, this result might not be desirable. Consider when an analog hard copy map is used as the 
base data. In this case, the corresponding numbers would be written directly on the map. Any changes in the 
sequence of the numbers requires a renumbering of the points on the hard copy. To avoid renumbering in 
such cases, add points to the end of the list.  

If you wish to toggle points on or off, double-click on the corresponding line. 

Edit > Modify Control Points 

Choose Modify Control Points to modify the selected pair of control points by manually editing the following 
coordinates: (Base X, Base Y) and (Uncorrected X, Uncorrected Y).  

The On/Off check button toggles this pair of points between on or off. When on, a pair is taken into account for 
the calculation of the actual model and the corresponding marks display in the appropriate views. When off, 
this pair of points is suppressed and the marks are not displayed. Alternatively, double-click on the 
corresponding line to toggle points on or off.  

Edit > Delete Control Points 

Choose Delete Control Points to remove the selected pair of control points from the list.  
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Edit > Highlight Control Points 

Choose Highlight Control Points to highlight the selected pair of control points. This feature uses the same 
color that MicroStation uses for highlighting elements when they are selected or identified.  

Edit > Locate Control Points 

Choose Locate Control Points to locate and highlight the selected pair of control points in the center of views 
that are set for locating control points (See “View > Views Used to Locate Control Points”). This feature is 
useful for rapidly panning to the location of control points that are not visible. The highlighting is done with the 
same color that MicroStation uses for selecting elements.  

Edit > Coordinate System 

Choose Coordinate System to enter a description for the coordinate system for the base data. The coordinate 
system identified here should be the one into which the image or vectors will be transformed when it is 
resampled through the resulting model (the base coordinate system, i.e., the system to which the base vector 
data belongs).  

View menu 

The View menu provides access to two toggles. One toggle controls the dynamic warping mechanism and the 
other, the display of control points. Dialog boxes are also provided to let you to select the views which will 
display the dynamic warping of vector on uncorrected data and to select the views which will display the 
location of control points. A final dialog is used to set the warping window.  

View > Dynamic Warping in Views Displaying Uncorrected Data 

Dynamic Warping in Views Displaying Uncorrected Data permits you to control the dynamic warping 
mechanism inside each view where uncorrected data is displayed.  

If on, it activates both the dynamic warping mechanism and the updating of the model. Each time that a pair of 
control points is entered or modified, the model is updated and the base vector data is warped. Base vector 
data is redrawn in views where uncorrected data is displayed, as an overlay to the uncorrected image(s) or 
vector(s), after being geometrically transformed through the actual model.  

If on and the model cannot be calculated with the present set of control points, the actual model displayed will 
be None and the dynamic warping will not be activated. 

Turn off to inhibit both the dynamic warping mechanism and the updating of the model; then, the Actual Model 
shown will be None.  

The dynamic warping process can take time to complete. If you wish to abort it, press the <Esc> key. It is 
recommended that you use a small set of base vector data in order to accelerate the dynamic warping 
process. If using a small set of base vector data is not practical, set the warping window so that only the 
design elements inside the area that you wish to register are warped. 

You can also control the warping process for each supported design element type. 

Panning in a view displaying uncorrected data is not recommended when dynamic warping is on. The warping 
of vectors takes some time and in some circumstances causes MicroStation to not trap the release of the data 
point button. When this happens, the panning does not stop and performance is seriously degraded. To 
prevent this situation, move the mouse to another window and click the Reset button (or press the <Esc> key 
and immediately click the Data button) several times until the panning ceases.  
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View > Views Displaying Uncorrected Data 

Choose Views Displaying Uncorrected Data to identify the view or views where the uncorrected data (the 
images or vectors to be corrected) will be displayed. If Dynamic Warping in Views Displaying Uncorrected 
Data is on, the base vector data will be warped over the uncorrected data in the specified views. It will be 
redrawn after being geometrically transformed through the actual model. In all other views, vector data will 
behave normally. The check button Also Display Non-Warped Elements controls the presence or absence of 
non-warped elements (i.e., the original design elements without transformation) in uncorrected views 

View > Views Used to Locate Control Points 

Choose Views Used to Locate Control Points to identify the view or views where the Locate Control Points 
feature will be activated (See “Edit > Locate Control Points”).  

When the Auto Locate on Base Control Point Pinning toggle is on, the selected views will be automatically 
zoomed around a base control point just after it is pinned. 

Use this feature when you want to refine the pinning of control points after you have done it approximately in a 
view with a smaller scale. 

For example, use View 1 for a synoptic display of the whole image. Use View 2 as the detailed view where a 
zoom occurs automatically after a base control point is selected. Then, View 2 should be selected in the Views 
Used To Locate Control Points dialog box. 

Here is a typical procedure you can follow as an example. 

To use a synoptic view and a detailed view when pinning control points 

1. Turn on View 2 in the Views Used To Locate Control Points dialog box.  
2. Turn on the Auto Locate on Base Control Point Pinning toggle. 
3. Select the Place Control Points tool from the Register tool box. 
4. Pin a base control point in View 1. View 2 automatically zooms around this point. 
5. If the pinning of this point needs refinement, press the Reset button. That removes the last base 

control point and allows you to pin it again (in the zoomed view). 
6. Pin the uncorrected control point and iterate the process from step 4. 

View > Warping Window 

Choose Warping Window to set the size of the warping window. The warping window is the extent in which the 
dynamic warping occurs if Dynamic Warping in Views Displaying Uncorrected Data from the View menu is on. 
You should set the size of the warping window if the extent of the design elements is larger than the area that 
you wish to register. If you choose this option, the time to warp the design elements is reduced since 
registration does not consider the elements outside of the warping window.  

View > Show Control Points 

Show Control Points permits you to control the display of control point marks.  

If on, activates the display of the control points mechanism. Then, both control points for all pairs of points are 
displayed according to the selected colors.  

If off, suppresses the display of the control points mechanism.  
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Settings menu 

Use Register/Settings to set the colors of the symbols that are used to mark the control points, to toggle on or 
off the Warning When Renumbering option, or to access the Elements Transformation dialog box. 

Settings > Colors for Control Points 

Choose Colors for Control Points to set the colors for the symbols that are used to mark control points. Colors 
for the base control points mark and the uncorrected control points mark can be set independently. Next to 
each field where the color number is entered, the actual color corresponding to this number displays on a color 
button. You can also select the color with the color picker that pops up when you click the color button.  

Settings > Warning when Renumbering 

Warning when Renumbering permits you to be warned when the list of control points is going to be 
renumbered. If a line is inserted or deleted before the last existing line in the control points list box, a 
renumbering of the next points results.  

If on, you are warned when a renumbering is about to occur.  

If off, you are not warned when a renumbering is about to occur. 

Settings > Elements Transformation 

Choose Elements Transformation to control which design element types are used for the dynamic warping 
process, the Copy Vectors command, and the Move Vectors command. To disable a specific design element 
type for the transformation process, select the None option for the appropriate option button.  

To enable a specific design element type, select the appropriate option for each design element type: 

• All Coordinates 
• Origin Only 
• Stroking & All Coordinates 

When All Coordinates is selected, the transformation model is applied to each (X,Y) coordinate of the element.  

When Origin Only is selected, the transformation model is applied only on the origin of the element. Others 
characteristics such as rotation angle, scale, and so forth are not modified.  

When Stroking & All Coordinates is selected, the transformation process modifies the original structure (i.e., 
center point, start angle, etc.) of the element. First, the element is stroked into a complex chain based on the 
specified Tolerance. Second, the transformation model is applied to each (X,Y) coordinate of the element. If 
the element does not transform as expected, adjust the Tolerance and repeat the process.  

Apply menu 

Apply > To Image 

Selecting To Image from the Apply menu opens the Resampling dialog box. Use the Resampling dialog box to 
set all parameters to resample an image through a geometric correction model built with Register. 
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5.6 Resample image tool 
 
 

Used to open the Resampling dialog box and quickly prepare a “fresh” resampling page by setting all 
parameters with default values: 

• In the Job Manager group, the tool goes to the first free page. 
• Input Image: the active image (if there is no active image when Resample Image is pressed, a 

message displays). 
• Output Image: the same name as Input Image, but with a sequential number (1, 2, 3, etc.) added at 

the end of the name. If the name already has eight characters, the last character(s) can be overwritten 
by the added digits. 

• Window: All Input Image. 
• In the Resampling group, all usual default are used. 

You can edit any parameter, or keep all defaults and run the page at once. 

 

 
Resampling dialog box 

Used to apply a geometric correction model to an uncorrected image. The input data is transformed into an 
output data set that belongs to the base coordinate system, directly compatible with the base vector data that 
was used to create the model. Choose To Image from the Apply menu of the Register dialog box to access the 
Resampling dialog box. 

 
 

Input Image field 

The Input Image field displays the name of the input image file. Click the Select button to open the File 
Selection dialog box. This dialog box is used to select an existing image file for resampling.  

Model field 

The Model field displays the name of the transformation model file. If there is an active model in the Register 
dialog box, it displays in this field. You are prompted to save it if you have made changes since the last save. 

To change the current selection, click the Select button to open the File Selection dialog box. This dialog box 
is used to select an existing RGR transformation model file for the resampling process. 
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Create a new image 

Used to choose whether you would like to actually resample the image or simply use the transformation matrix 
to apply your changes.  

The toggle is automatically checked when the Resampling Dialog opens, but when a Helmert, Similitude, or 
Affine model is selected, the toggle is automatically unchecked but remains enabled. When a Projective, Thin 
Plate Spline or Polynomial model is selected, the toggle is checked and disabled, since the transformation 
matrix does not support these models. 

Because the transformation matrix is a new addition to Bentley Descartes, Register operations 
performed solely with the transformation matrix will not appear if the file is opened in Bentley Descartes 

6.0. If you plan to use an image in a previous version of Bentley Descartes and would like it transformed, you 
may wish to resample the image at this time. 

Only file formats which support a transformation matrix will maintain mirroring operations stored in the 
transformation matrix. For all file formats without a transformation matrix, such as standard TIFF or BMP 

files, Bentley Descartes adds a worldfile. However, if this TIFF or BMP are opened in an application where 
worldfiles are not supported, the information in the transformation matrix will not be applied to the image. If you 
plan to use a file format which does not support a transformation matrix in another application, you may wish 
to select Create A New Image and resample the image at this time. 

If you decide to use a file format that does not support a transformation matrix, it is possible to resample the 
image using its own transformation matrix. In order to do this, simply leave the Model: field empty and 
resample. You can also resample a file with its own transformation matrix by using Save As or Batch Convert. 

Output Image field 

The Output Image field displays the name of the output image file. Click the Select button to open the File 
Selection dialog box. This dialog box lets you specify the name of the image file that will be created by 
resampling.  

All Input Image 

Use All Input Image to define the output window in such a manner that it covers the input image entirely.  

All Input Image/Input 

Click the Input button with the All Input Image option to open the Input Image Window dialog box. The name of 
the input image displays in the title bar. No parameter of this dialog box can be edited. This dialog box is used 
only to display the actual window of the input image, as well as with content reflected in the header of this 
image.  

All Input Images/Output 

Click the Output button with the All Input Image option to open the Output Window dialog box. The name of the 
output image displays in the title bar.  

If an output image is not selected, Untitled is displayed. No window parameter (origin or dimension) of this 
dialog box can be edited. The dialog box is used only to display the window of the output image.  

The output window is calculated automatically to cover the entire input image. Only the description of the 
output image and the pixel size can be entered using the Output Window dialog box. This information is used 
to prepare the header of the output image.  
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Specified through Input 

Use the Specified through Input option to define the output window through another window which is set in the 
input system of coordinates.  

Specified Through Input/Input 

Click the Input button to specify the origin and the dimensions of the input window. The name of the input 
image and other information is displayed, but cannot be edited. When the output window is set through the 
input space, it adjusts accordingly and in such a manner that it covers the input window entirely.  

Specified Through Input/Output 

Click the Output button to open the Output Window dialog box. The name of the output image displays in the 
title bar. If an image is not selected, Untitled is displayed. No window parameter (origin or the dimensions) of 
this dialog box can be edited. The dialog box is used only to display the window of the target output image. 
The values are calculated automatically to cover the input window entirely. Only the description of the output 
image and the pixel size can be entered using the Output Window dialog. This information is used to prepare 
the header of the output image.  

Warping Window 

Use the Warping Window option to define the output window by setting its equivalent to the warping window 
defined with the Warping Window dialog box. 

Specified in Output Space 

Use the Specified in Output Space option to define the output window by setting it directly in the output space. 

Specified in Output Space/Output 

Click Output button with the Specified in Output Space option to open the Output Window dialog box. The 
name of the output image displays in the title bar. If an image is not selected, Untitled is displayed. This dialog 
box can be used to specify the true origin and dimensions of the output window. All other fields can also be 
entered or edited in order to prepare the header of the output image.  

Type 

Three algorithms can be chosen through the Type option menu: 

• Nearest Neighbor  
• Bilinear Interpolation  
• Cubic Convolution  

The Nearest Neighbor algorithm uses only one input pixel. Bilinear Interpolation uses the four nearest 
neighbors and calculates the weighted mean. Cubic Convolution uses a four by four matrix of pixels and 
calculates a type of weighted mean.  

The Nearest Neighbor algorithm is faster, but it can cause jagged edges or lines on the output image. Cubic 
Convolution usually produces the best results, but the calculation requires more time to process than the other 
algorithms. The Bilinear Interpolation provides a compromise in quality of output and time to process.  
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Pixel Size 

Three choices are available: 

• Keep File Size 
• Same Pixel Size 
• User Defined. 

Use the Pixel Size field to enter the size of pixels for the output image. With the “User Defined” option, you can 
enter different X and Y value.  

Except for special effects, it is recommended that you set the pixel size of the output image equal to or 
close to the pixel size of the input image.  

Background Color 

The background color is a RGB color number used to initialize the output image file prior to resampling. 
Therefore, any part of the output image which is not covered by resampled pixels remains this color. You can 
enter the background color index into the Background Color field. You can also select the color with the color 
picker that pops up when you click the color button.  

Page Up/Page Down 

In Register, each file submitted for resampling has each of the resampling parameters displayed in the Job 
Manager group boxes. The values for each file can be viewed and edited by scrolling the individual pages. 
Use the Page Up or Page Down buttons to move from the current page to the previous or next page. If the 
Page Down button is pressed when there is not an additional page, a prompt asks you if you wish to open a 
new page. If you open a new page, it is created with the default parameters.  

Delete Page 

Click the Delete Page button to delete the current page and all of its parameters. This page is removed and all 
following pages are renumbered. If the first and only page is deleted, it remains open and the parameters are 
established with the default settings.  

Delete All 

Click the Delete All button to delete all pages but the first page. The parameters of the first page are 
established with the default settings. 

Run Page 

Click the Run Page button to start the resampling process according to the parameters of the current page. 
Before a job is run, the available disk space is checked based on the estimated file size. If the Data 
Compression is None and there is not enough space, the resampling job is not run and you are notified by a 
warning box. 

While the batch program is running, a Progress window provides feedback. After the job is completed or 
terminated, a Report line displays the result of the processing corresponding to this page. It indicates whether 
the processing was successful and, if not, it declares what error or event caused it to be unsuccessful.  
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Run All 

Click the Run All button to start the resampling process of all pages, one at a time, according to the 
parameters of each page. While the batch program is running, a Progress window provides feedback. For 
each page, a Report line displays the result of the batch processing job corresponding to this page. It indicates 
whether the processing of this job was successful and, if not, it declares what error or event caused it to be 
unsuccessful.  

Page 

The Page field indicates the number of the current page and the total number of pages prepared.  

Report 

For each page, a Report line displays the result of the processing that corresponds to this page. It indicates 
whether the processing was successful and, if not, it declares what error or event caused it to be unsuccessful.  

File menu 

The File menu of Resampling provides access to all necessary options to manage Resampling files (RSP 
files). A Resampling file is used to save a schedule of images to be resampled. It can be opened later and be 
batch processed.  

  

5.7 Copy Vector tool 

Click the Copy Vector tool to copy vectors through the active transformation model. To control which design 
elements types should be affected (See “Settings > Elements Transformation”). 

If there is not an active transformation model, you are informed. In this circumstance, you should load a 
transformation model using the File/Open option from the Register dialog box or build one using the Control 
Points tools from the Register tool box.  

To apply the registration model to the vectors 

1. Select Copy Vector.  
2. Choose the Direction of the transformation from the option button. Choices are Base to Uncorrected or 

Uncorrected to Base.  
3. Identify an element from the appropriate geometry (Base or Uncorrected) according to the selected 

Direction.  
4. Accept the element, or reject and retry.  

To constrain the copy with a Fence or Selection Set 

1. Select Copy Vector.  
2. Choose the Direction of the transformation from the option button. Choices are Base to Uncorrected or 

Uncorrected to Base.  
3. Draw a fence or build a Selection Set using the MicroStation tools.  
4. Select Copy Vector again.  
5. You are asked to confirm the operation on all selected elements. Click OK to proceed or Cancel to 

cancel. 
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5.8 Move Vector tool 

Click the Move Vector tool to move vectors through the active transformation model. To control which design 
elements types should be supported (See “Settings > Elements Transformation”). 

To apply the registration model to the vectors 

1. Select Move Vector.  
2. Choose the Direction of the transformation from the option button. Choices are Base to Uncorrected or 

Uncorrected to Base. 
3. Identify an element from the appropriate geometry (Base or Uncorrected) according to the selected 

Direction (elements from a Reference file or locked elements cannot be identified).  
4. Accept the element, or reject and retry.  

To constrain the move with a Fence or Selection Sets 

1. Select Move Vector.  
2. Choose the Direction of the transformation from the option button. Choices are Base to Uncorrected or 

Uncorrected to Base.  
3. Draw a fence or build a Selection Set using the MicroStation tools.  
4. Select Move Vector again.  
5. If at least one of the selected elements is in a reference file, you are informed that this operation is not 

possible. Otherwise, you are asked to confirm the operation on all selected elements. Locked 
elements are not moved. Click OK to proceed or Cancel to cancel.  
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6.0 Mosaicking 
 
The Mosaic tool box tools will help you create mosaics, making all images look alike by changing the color and 
by cutting the overlapping sections and applying the feathering tool to hide the seam of the cut. 
 
 
 
6.1 Mosaic tool box 
 
The Mosaic toolbox is used to balance the tone between all images of a mosaic and to automatically, or semi-
automatically, create a mosaic by cutting the overlapping sections and applying the feathering tool to hide the 
seam of the cut. 
 
The Mosaic toolbox displays two tools, Balance Tone and Define Seam. 
 

To Select in the Mosaic tool box 

Balance the tone of colors between all of the images of a mosaic. 

  
 

  

Balance Tone Tool

Define the position of the seam between two overlapping image portions of 
a mosaic and to remove the portion defined by the seam from the top 
image. 

  
 

  

Define Seam Tool
 
 
 
 
 
6.2 Balance Tone tool 
 

Use the Balance Tone tool to when you want to balance the tone of colors between all of the images of a 
mosaic. 

Upon selecting the Balance Tone tool, the tool settings box displays two option lists, Mode and Source Area: 

Tool Setting Effect 

Mode 

Mode represents the method to be used for tone balancing.  

• Average - Averages the tone by using all selected images and averaging a unique color 
table that is applied to all the selected images. All selected images are altered based on 
the tone average and standard deviation from the image selection set. The Average 
method is useful when all images look good but are not perfectly balanced. Average is 
the default option. 

• From Reference - Utilizes a source image color table to balance the selected images. 
From Reference should be used when one image of the mosaic, or an area of the 
image, looks particularly good and all other images of the mosaic should look similar. 
Tone Balance is performed for each selected image, except the reference image, to 
match the Reference Area. The Reference Area is selected by using one of the 
available options under the Source Area option list 
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 When Average is selected, only Entire Images and Overlaps are available from the 
Source Area option list. The other areas, Block, Oriented Block, Element and Fence are 
not available.  

 

Source Area 

Source Area represents the area of the selected images to which tone balance will be 
applied. Possible areas are listed below. 

• Entire Images 

Average mode: 

All pixels of all selected images are used for the Balance Tone computation. 

From Reference mode: 

The complete reference image will be used. The Histogram of the Reference image is 
applied to the selected images. 

• Overlaps 

Average mode: 

Only the overlapping pixels of all the selected images are used for the Balance Tone 
computation. 

From Reference mode: 

Pixels of the overlapping portion of the reference are used to compute the new 
histogram that is applied to all selected images. 

• Block (Available with From Reference only) 

In the Block source area, the area is chosen by entering a block shape selection on the 
Reference Image. This technique allows you to sample pixels of a specific area of the 
reference image. 

• Oriented Block (Available with From Reference only) 

In the Oriented Block source area, the area is chosen by entering an oriented block 
shape on the Reference Image. This technique allows you to sample pixels of a specific 
area of the reference image. 

• Element (Available with From Reference only) 

In the Element source area, the area is chosen by selecting a closed design file 
element. This technique allows you to only sample pixels of a specific area of the 
reference image using a non-reticular shape. The pixels comprised inside the element 
are used to compute the new histogram that will be applied the all selected images. 

•  (Available with From Reference only) 

In the Fence source area, the active fence is used to select the pixels that are used to 
compute the new histogram that is applied to the selected images. 
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To Tone Balance with Average Mode 
1. From the Raster Manager Tools menu, choose Image>Mosaic 
The Mosaic toolbox opens 

2. In the Mosaic toolbox, select the Balance Tone tool 

3. From the Tools Settings box, set: 
Mode: Average 
Source Area: Entire Images  

 
If the images you want to process are already selected 
(multiple-selection) – proceed to step 6. 

4. Select the first image by pointing at the image and enter a data point. 

5. Repeat step 4 for remaining images to be balanced. 

6. Reset to accept the image selection set. 

7. Enter a data point to process the image selection set. 

8. The images from the selection set are now balanced. 

 

To Tone Balance with From Reference Mode 

1. From the Raster Manager Tools menu, choose Image>Mosaic 
The Mosaic toolbox opens 

2. In the Mosaic toolbox, select theBalance Tone tool 

3. From the Tools Settings box, set: 
Mode: From Reference 
S

 

4. S nd enter a data point. 

5. R
D

6. R

7. S

8. E

9. T

 
 
 
 
 
 
 

ource Area: Entire Image  
If the images you want to process are already selected 
(multiple-selection) – proceed to step 6. 

elect the first image by pointing at the image a
epeat step 4 for all the other images to be balanced. 
O NOT select the image that is used as the reference. 

eset to accept the image selection set. 

elect the reference image by pointing at the reference image and enter a data point. 

nter a data point to process the image selection set. 

he images from the selection set are now balanced using the reference image. 
The reference image is not modified. 
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6.3 Define Seam tool 
 
 
Use the Define Seam Tool to define the position of the seam between two overlapping image portions of a 
mosaic and to remove the portion defined by the seam from the top image. Define Seam may also apply the 
feathering tool to the seam. All options are available through the tools settings dialog. 
 

 
     Example of an Overlap 

 
Tool Setting Effect 

Seam Type 

A seam is defined as a segment between the two intersection points of the overlapping area.

•  Quick: 

Used to quickly mosaic two images. The seam is automatically defined by the tool. If 
feathering is ON, you have control over the width of the feathering. 

• User-Defined: 

In this mode, the seam is attached to the pointer and you have control over the 
placement of the seam. You can enter as many points as required to position the seam. 
Once in place, a reset confirms the placement of the seam. 

The area that will be remove is processed exactly the same way as the Quick mode 
(see graphic above). 

Turning ON Feathering will feather the seam, equidistant from the center, using the 
value from the Width field. 

Turning ON Save Seam will, after the mosaicking process is executed, convert the seam 
into a design file element. It is therefore possible to utilize this seam again (see Element 
Mode below). 

• Element: 

In this mode, the seam line is defined by selecting a Design File Element. 

If an invalid seam is detected, it will be rejected and a message will be displayed in the 
status bar. 

• The element must not be closed, such as a Line String, and must have 2 intersection 
points with the overlapping area of the two images.  

• Smart 

In this mode, the seam line is drawn at the very middle of the overlapping area regardless of the 
image intersections.  
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Feathering When this option is ON, feathering is enabled. Feathering is a “camouflage” technique that 
allows the seam “cut-line” to fade into the image. 

Width 

Used to specify the width of the feathering. The width is given in working units and is applied 
equidistantly on both sides of the seam. 

A good value for a seam is determined by the scale factor and the resolution of the image. 
Generally, the seam will be large enough to hide the cut line on the image created by the seam. 
Nevertheless, you may consider a narrower feather value if objects, such as buildings, are within 
the feathering area. 

Feathering can also be used to create aesthetic scenes such as embedding a thumbnail. 
 
 

To Mosaic Two Images Using Quick Mode 

1. From the Tools menu, selectImage>Mosaic 
The Mosaic toolbox opens 

2. Select Define Seam tool 
3. From the Tools Settings box, set: 

Seam Type: Quick 
Feathering: ON 

4. Select the first image to mosaic by moving the pointer over it and enter a data point. 
A blue outline surrounds the image. 

5. Select the second image as in step 4. 
A blue outline surrounds the image. The “Seam” is displayed with the feathering width highlighted. 
Zoom in as necessary to see the width of the feathering. 

6. Adjust the width as necessary by typing a new number in the width field of the tool settings box, then 
press Enter to activate the new width. 
The Seam will resize automatically. 

7. When you are satisfied with the results, enter a data point to begin the mosaicking process. 

 
 
 
 
 
 

The images now form a seamless mosaic!
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7.0 Color Masking 

This chapter discusses how to prepare color masks that will be used by 
various editing or vectorizing tools, as well as transformation tools. 

The Color Mask tool (previously named filters) was enhanced to support 24-bit images. A color mask is a list of 
RGB colors defining a specific subset of colors. A color mask is normally assigned, to one or several images. 

 
 
7.1 Color Mask Applications 
 
A color mask lets you handle any image with more than two colors exactly as if it was a two-color image. It 
dynamically converts all colors of the mask into the “drawing” color, and all the rest into the “backfill” color. A 
color mask cannot be defined for two-color images, as they already have only a foreground color and a 
background color. All tools used for image editing or vectorization, normally work with binary (two color) 
images only. Because of the color mask feature, these tools can now be used with images that have more 
than two colors. 
 
A color mask specifically determines what will be considered as the “drawing” colors for various “raster” 
operations. For a given image, you can define an unlimited number of color masks to be saved in the same 
color mask file. For example, all colors rendering red lines on a scanned map constitute a color mask, while all 
colors rendering green lines or bodies constitute another mask. Another class of raster objects can be 
rendered with a mixture of red and green pixels that compose another color mask. A given color can be 
present in more than one mask. 
 

In the Color Mask dialog, one default mask will always be available even when no mask file is opened: 

• The (Temp) mask is an editable mask that is never saved in a mask file. 

A new mask concept, “Chameleon-Mask” is introduced in Bentley Descartes. This special mask is similar to 
the standard mask except that it can have one or more sub-masks that are a specialization of the parent mask 
for a specific image. The mask can be applied to any image and the sub-mask will be applied only on the 
image to which they have been assigned. The names of the masks included in the chameleon mask are 
automatically generated. Using the following rules generates the name of each mask: 

• The name of the parent mask.  
• An underscore. 
• The name of the image to which the mask is attached (with no path). 
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7.2 Color Mask tool box 
 
 

The Color Mask tool box provides tools to add color indices to a mask, to subtract indices from a mask, or to 
open the Color Mask dialog box. 

The Color Mask tools and functions are not available for two-color images. 

 
To Select in the Color Mask tool box

Add a selection set of color indices to the selected color mask. 

  
 

  

Add to Mask tool

Remove a selection set of color indices from the selected color mask.

  
 

  

Subtract from Mask tool

Open the Color Mask dialog box. 

  
 

  

Color Mask Dialog tool
 
 
 
 
 
7.3 Add to Mask tool  
 
 
Used to add a selection set of color indices to the selected color mask. 
 
 

 
 
Tool Setting Effect 

Area 

• Block: Using the pointer draw a rectangular block over the colors to add. 
• Element: Using the pointer, select a closed element that delimits the region to include. 

All colors comprised in the element are added to the color mask. 
• Fence: The colors in the fence are included.  

Mask Used to select in which mask the colors are added. The drop-down list shows the existing masks 
that can be edited.  

Highlight Use to turn the highlight feature ON or OFF. The highlight feature changes all pixels that match 
the color(s) of the selected color mask to the highlight color. 
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To add colors to a color mask 

1. Click the Add to Mask tool. 
The tool settings window opens. 

2. In the tool settings window, set the area (element, block or fence) and select the mask in which the 
colors will be added. 

3. Select the area (element, block, or fence) in the image.  
All the colors found under the selected area are automatically added to the mask. 

 
 
 
7.4 Subtract from Mask tool 
 
 
Used to remove a selection set of color indices from the selected color mask. 
 
 

 
 
 
 
Tool Setting Effect 

Area 

• Block: Using the pointer draw a rectangular block over the colors to add. 
• Element: Using the pointer, select a closed element that delimits the region to include. 

All colors comprised in the element are added to the color mask. 
• Fence: The colors in the fence are included.  

Mask Used to select in which mask the colors are added. The drop-down list shows the existing masks 
that can be edited.  

Highlight Use to turn the highlight feature ON or OFF. The highlight feature changes all pixels that match 
the color(s) of the selected color mask to the highlight color. 

 
 

To subtract colors from a color mask 

1. Click the subtract from Mask tool. 
The tool settings window opens. 

2. In the tool settings window, set the area (element, block or fence) and select the mask from which the 
colors will be subtracted. 

3. Select the area (element, block, or fence) in the image.  
All the colors found under the selected area are automatically subtracted from the mask. 
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7.5 Color Mask Dialog tool 
 
 
Use to create and manage Color Masks. A mask can be assigned to any image regardless of the pixel type 
(except for binary images). When adding colors to a mask, it is possible to select the area on any image 
currently open in Raster Manager. 
 
 
7.6 Color Mask tool settings 
 
File Menu: 

 

 
 

• New — Use to create a new empty color mask file.  

• Attach — Use to attach a saved color mask file.  

• Save — Use to save the active color mask file. 

• Save As — Use to save the current color mask file under a different name. 

 
Settings Menu: 
 

 
 
 
Provides access to the Highlight Settings dialog. 
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• Highlight Color — Opens the MicroStation color selector dialog to select the highlight color. The 
default color is red (255, 0, 0).  

• Highlight Level — Selects the percentage of opacity for the highlight color. The default level is 100% 
(opaque). 

 
 
Tools Menu: 
 

The Tools menu offers different choices depending of the current selection in the Color Mask dialog.  

A mouse right-click on the selection provides a context sensitive menu that corresponds to the tools menu. 

 

• New Mask (or New Sub-Mask) — If a File Name is currently selected, a new mask is created.  

If a mask is currently selected, the mask is transformed to a chameleon mask and a sub-mask is 
created in the mask. 

If a chameleon mask is currently selected, a new sub-mask is created in the currently selected mask. 

Multiple selections are not supported. 

• Duplicate — If a mask is currently selected, a copy of the mask "xyz" is made. The new mask is 
named "copy of xyz"  

Multiple selections are not supported. 

• Rename — Changes the name of the currently selected mask or chameleon mask.  

Multiple selections are not supported. 

• Delete — Delete the selected mask, chameleon mask or chameleon sub-mask from the mask file.  

Multiple selections are supported. 

• Highlight — The selected mask, chameleon mask or chameleon sub-mask is highlighted until the next 
"refresh".  
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Multiple selections are not supported. 

• Add Colors — Allows selection of colors by drawing a block on the screen to add colors to the selected 
mask.  

If a chameleon mask is selected, the new colors will be added to the parent mask. 

Multiple selections are not supported. 

• Subtract Colors — Allows to draw a block on the screen to subtract colors from the selected mask.  

If a chameleon mask is selected, the new colors will be subtracted from the parent mask. 

Multiple selections are not supported. 

• Use Palette Selector — Allows to select colors from a color palette. Available only if the selected 
image has a color palette. 

 

 
 
 

• Add All — Add all colors to the selected mask, chameleon mask or chameleon sub-mask.  

Multiple selections are not supported. 

• Subtract All — Subtract all colors from the selected mask, chameleon mask or chameleon sub-mask.  

Multiple selections are not supported. 

• Invert All — Invert all colors of the selected mask, chameleon mask or chameleon sub-mask.  

Multiple selections are not supported. 
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8.0 Editing Images 
 

This chapter describes a set of tools that permit drafting and drawing in raster, erasing raster objects, cleaning 
images, copying and pasting pieces of images, as well as undoing and redoing image editing operations. 

Bentley Descartes provides a rich set of tools to edit images. 

Touch-up tools are used to remove unwanted pixels in an image, to improve the quality of raster linework or 
other objects or to paint images. Simple but powerful brushing tools are used to paint or edit an image. Copy 
and Paste tools are used to copy a region of an image and paste it to another image.  

This set also provides flexible raster drafting tools. Stamp Vector tools are used to stamp design vectors into a 
raster file, or to draw directly in raster with the full range of MicroStation vector drawing and annotation tools.  

With these tools, you can: 

• Despeckle an image. 
• Fill holes in an image. 
• Copy a region of an image.  
• Paste a copied region to an image or to a design file. 
• Dynamically draw in raster with MicroStation vector tools.  
• Stamp vectors into an image. 
• Paint an image. 

 
 
8.1 Touch-up tool box 
 
 
The Touch-up tool box contains the following tools: 
 
 

To Select in the Touch-up tool box 

Paint the image inside an area 

  
 

  

Paint Area tool

Erase the image inside an area 

  
 

  

Erase Area tool

Remove speckle from the image inside an area

  
 

  

Cleanup tool
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8.2 Paint tool 
 
 
Use to apply color to images. Use the Tool Settings to set specific parameters such as the Color Mask to use. 
Only the selected images are processed with the tools. 
 

 
 
The Paint tool modifies only the pixels in the selected mask. 
 
Tool Setting Effect 

Area 

 
Use to select the shape of the brush. Available options are listed below. 

• Block: Using the pointer, select two data point to create a block. 
• Element: Using the pointer, select an element to paint all pixels within the element.  
• Fence: Using the pointer, the active fence is used to paint all pixels within the fence 

definition. 
• Image: Paints the entire image. 

Color 
 
Use to specify the paint color.  
 

Paint Mask 
 
Select the mask to use. For more details, please refer to the Color Mask section. 
 

 
 

To paint inside an area 

1. Select the Paint Area tool. 
2. For images with more than two colors, select the appropriate color mask to determine the pixels to be 

painted, and select the target color. 
3. Select the Area option. 
4. Follow the instructions to define, select, or accept the area.  

The pixels inside the area are painted. 

 

When the area is a raster object, this object highlights for acceptance before the paint is executed. 
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8.3 Erase tool 
 
 

Select Erase from the Touch-up tool box to erase the image inside an area. Only the selected images are 
processed with the tools. 

The Erase tool modifies all the pixels underneath the brush. The color mask "(All)" is used and the paint color 
is the "(Backfill)" color. 

Tool Setting Effect 

Area 

Use to select the shape of the brush. Available options are listed below. 

• Block: Using the pointer, select two data point to create a block. 
• Element: Using the pointer, select an element to paint all pixels within the element.  
• Fence: Using the pointer, the active fence is used to paint all pixels within the fence 

definition. 
• Image: Erase the entire image. 

 

To erase an area on an image 

1. Select the Erase tool. 
2. For images with more than two colors, select the color. 
3. Select the Area option. 
4. Follow the instructions to define, select, or accept the area. 

The pixels are erased inside the area. 

 
 
8.4 Cleanup tool 
 
 
Used to cleanup an image area. Remove Speckle or Remove Hole are the available cleanup methods. Only 
the selected images are processed with the tools. 
 

 
 
Tool Setting Effect 

Size Displays the speckle (or hole) size to be removed in working units. The yellow ruler allows 
measuring the speckle on the screen. 

Method Select the method to use: “Remove Speckle” or “Remove Hole”. 
Area Define the area where the function will be applied. 

Color Select the color to use to paint over the speckles (or holes). For binary images, the backfill color 
is used for Remove Speckle and the drawing color for Remove Hole. 

Cleanup 
Mask Select the mask to use. 
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8.5 Stamp Vector tool box 
 
 

The Stamp Vector tool box is used to stamp design vector elements into raster images in the specified view. 

Use Stamp Vector to: 

• Add raster representation of design elements to image files. 
• Edit raster using MicroStation vector drawing and annotation tools. 
• Create image files that contain raster and vector information and that can be exported easily for use in 

other applications. 

To Select in the Stamp Vector tool box

Stamp design vector elements into raster images. 

  

 
  

Stamp Vector tool

Sets the Working Units section using the current zoom factor to 
determine the size for each Line Weight and Style. 

  

 
  

Match Stamp Vector Settings Tool

Opens the Stamp Vector Settings dialog box. 

  

 
  

Stamp Vector Settings tool
 
 
 
8.6 Stamp Vector tool  
 
 
Use Stamp Vector to stamp design vector elements into raster images. Vector elements can be stamped 
interactively or all selected vector elements can be stamped at once. 
 

To interactively stamp a vector element into images 

1. Unselect any selected elements by entering a data point with the MicroStation Element Selection tool. 
2. Select Stamp Vector.  
3. Specify the view in the Tool Settings dialog where you want to stamp vector elements.  
4. Identify a design vector element.  
5. Accept the element (or reject and retry).  

If there are no images or only read-only images underneath the vector element, it cannot be stamped 
and an alert displays. 
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To stamp a set of vector design elements into images 

1. Select the elements you want to stamp with the MicroStation Element Selection tool.or 
2. Place a fence around the elements you want to stamp. 

Only the Inside mode is supported. 
3. Select Stamp Vector.  
4. Specify the view where you want to stamp vector elements.  
5. Enter a data point to accept the settings.  

If there are no images or only read-only images underneath the selected vector elements, no element 
can be stamped and an alert displays. 
With both of the above procedures, stamping occurs on all images which are on in the Raster 
Manager list box for the specified view. That is done in a WYSIWYG manner. If a vector element is 
displayed over an image in the specified view, the element is stamped into the non-transparent portion 
of this image. If two images overlap, the vector elements stamp into both images. Transparent parts of 
the images are not stamped. 

Stamping large elements or a large number of elements may take time. 

 
 
 
 
8.7 Match Stamp Vector Settings tool 
 
 

Match Stamp Vector Settings provides an efficient way to setup the Stamp Vector Settings. Match Stamp 
Vector Settings sets the Working Units section using the current zoom factor to determine the size for each 
Line Weight and Style.  

Since Line Weights and Styles always display at the same ratio regardless of the zoom factor, for each level of 
zoom, the element covers more or less pixels. Therefore, when zoomed far out, the element covers more 
pixels than when zoomed in. It is this coverage, in Working Units, that is used to modify the Stamp Vector 
Settings. This allows a constant ratio between View display and Raster Resolution. 

To setup Stamp Settings with Match Stamp Vector Settings 

1. From the Stamp Vector toolbox, select Match Stamp Vector Settings 
2. Enter a data point to confirm the current zoom factor. 

If you wish another zoom factor, simply select a tool of your choice and then reset to fall back to the 
Match Stamp Vector Settings tool in order to enter the data point conforming the current zoom factor. 

3. The Stamp Vector Settings Working Units are now modified to reflect the raster resolution size for 
each weight at the current zoom factor. 

 

The Stamp Vector Settings for PIXELS are NOT changed. 
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8.8 Stamp Vector Settings tool 
 
 
Selecting Stamp Vector Settings opens the Stamp Vector Settings dialog box. 
 
 
Stamp Vector Settings dialog box 

The Stamp Vector Settings dialog box is used to set the line weight and line style parameters used for 
rasterizing the vector elements, to turn on or off the Automatic Vector Stamping toggle, and to set other 
parameters controlling this function. 

 
 
 

System Units for Line Weight and Line Style 

This group is used to specify the units that will be used with the parameters in the Line Weight and Line Style 
groups, and to scale all displayed values. 

Scale 

All parameters in the Line Weight and Line Style group will be affected with this multiplying factor when a 
vector is stamped. 

Line Weight 

Use the Line Weight group to define each of the 16 standard line weights (0 to 15) in working units. If you are 
using a custom line style, the working units settings specified in MicroStation is determined automatically by 
the Stamp Vector tool. When a vector element is stamped into an image, the weight of a line is translated into 
the corresponding width specified in working units. 
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Line Style 

Use the Line Style group to define each of the eight styles (0 to 7) in working units. If you are using a custom 
line style, the working units settings specified in MicroStation is determined automatically by the Stamp Vector 
tool. When a vector element is stamped into an image, the style of a line is translated into the corresponding 
set of dashes and gaps specified in working units. You can define a sequence of up to four pairs of dashes 
and gaps for each line style. This sequence is drawn repeatedly when a line is stamped. 

Automatic Vector Stamping 

When on, all elements normally written to the design file will be stamped with the present settings. 

OK 

Use the OK button to save the present settings and close the dialog box. 

Cancel 

Use the Cancel button to close the dialog box without saving the present settings. 

 

 
A limited set of Stamp Vector Settings is also located in the Descartes category of the Preferences dialog box. 

From the MicroStation Workspace menu, select Preferences, then choose "Descartes" in the Category list, 
and select the Stamp Vector tab. 
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8.9 Cut/Copy/Paste tool box 
 
 

The Cut/Copy/Paste tool box is used to copy and paste regions of images, and to set parameters that control 
the copy/paste capabilities. 

Copy only acts on the raster objects inside an area. The pixels inside this area that are not part of the raster 
objects are treated as transparent when the cut region is pasted into the image. 

For two-color images, an image area is defined as all pixels of the foreground color inside an area. 

For images of more than two colors, an image area is defined as all contiguous pixels that satisfy the active 
color filter inside an area.  

To Select in the Copy/Paste tool box

Cut an image area from the active image to the clipboard. 

  
 

  

Cut Image Area tool

Copy an image inside an area from the active image to the clipboard. 

  
 

  

Copy Image Area tool

Paste an image area from the clipboard at a specified location in the 
active image. 

  
 

  

Paste Image Area tool
 
 
 
 
8.10 Cut Image Area 
 

Select Cut Image Area from the Cut/Copy/Paste tool box to cut an image inside an area from the active image 
to the clipboard for subsequent pasting.  

It is not necessary to select any images to use this tool. Simply select an area on the screen and cut it to the 
clipboard, no matter which image is currently selected. The function will read sections in as many files as the 
area overlaps. If the pixel size is not the same in all the files, the images will be resampled to the smallest pixel 
size to avoid loosing information in any files.  

To avoid problems caused by images with different color types, the information is kept in 24 bit in the 
clipboard.  

The copy function is WYSIWYG, which means that transparency, contrast, brightness, gamma correction and 
more will be applied before the data is copied to the clipboard.  
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8.11 Copy Image Area tool 
 

Select Copy Image Area from the Copy/Paste tool box to copy an image inside an area from the active image 
to the clipboard. 

It is not necessary to select any images to use this tool. Simply select an area on the screen and copy it to the 
clipboard, no matter which image is currently selected. The function will read sections in as many files as the 
area overlaps. If the pixel size is not the same in all the files, the images will be resampled to the smallest pixel 
size to avoid loosing information in any files.  

To avoid problems caused by images with different color types, the information is kept in 24 bit in the 
clipboard.  

The copy function is WYSIWYG, which means that transparency, contrast, brightness, gamma correction and 
more will be applied before the data is copied to the clipboard.  

 
 
 
8.12 Paste Image Area tool 
 

Select Paste Image Area from the Copy/Paste tool box to paste an image area from the clipboard at a 
specified location in the active image. 

When Paste Image Area is selected, the outline of the image area in the clipboard displays under the cursor. 
Move it to the desired location and enter a data point to paste the image area. 

It is not necessary to select any images to use this tool. All the selected files touched by the paste will be 
modified. If one of the touched files is not selected, an Alert appears giving you the option to paste on this 
image or to automatically select the image.  

If one of the touched file does not have a 24 bit color type, each pixel is moved to the nearest color available.  

This tool allows you to interactively change the shape of the pasted area (location, scale, rotation, and affinity).  
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